ES-200/ES-300W/ES-300WR
User's Guide
## Contents


**Scanner Basics** ......................................................................................................................................................... 8
  - Scanner Parts Locations ................................................................................................................................. 8
  - Scanner Parts .................................................................................................................................................... 8
  - Scanner Buttons and Lights ........................................................................................................................... 12
  - User Replaceable Epson Scanner Parts and Accessories ................................................................................. 14

**Changing the Power Save Settings** ......................................................................................................................... 14

**Charging the Battery (ES-300W/ES-300WR)** ........................................................................................................... 15

**Loading Originals** .................................................................................................................................................... 18
  - Loading Originals in the Input Tray ................................................................................................................ 18
  - Original Document Specifications ................................................................................................................. 25

**Loading Receipts in the Input Tray** ......................................................................................................................... 27
  - Receipt Specifications .................................................................................................................................. 32

**Loading Special Originals** .................................................................................................................................. 32
  - Special Original Specifications ..................................................................................................................... 38

**Loading Plastic Cards in the Card Slot** .................................................................................................................. 39
  - Plastic Card Specifications ........................................................................................................................... 43

**Wi-Fi Networking** ................................................................................................................................................... 44
  - Network Security Recommendations ........................................................................................................... 44
  - Connection Mode Switch ............................................................................................................................... 45
  - Connecting to an Existing Wi-Fi Network ..................................................................................................... 46
    - Manually Connecting to a Wi-Fi Network .................................................................................................... 47
    - Wi-Fi Protected Setup (WPS) ..................................................................................................................... 48
      - Using WPS to Connect to a Network ........................................................................................................ 49
      - Using WPS PIN Mode to Connect to a Network ....................................................................................... 51
    - Setting Up Network Scanning .................................................................................................................. 54
      - Determining the Scanner's IP Address ..................................................................................................... 56
    - Epson DocumentScan App for iOS/Android ............................................................................................ 57
    - Restoring Default Network Settings ........................................................................................................ 57
  - Connecting to a New Wi-Fi Router or Network ............................................................................................... 59
Solving Scanning Problems ................................................................. 134
Scanner Does Not Turn On or Turns Off Unexpectedly .................. 134
Scanner Button Does Not Work as Expected .............................. 136
Scanning Software Does Not Operate Correctly ............................ 136
Cannot Start Epson Scan 2 ............................................................... 137
Original Feeds Incorrectly in Scanner ............................................ 138
Original Jams in Scanner ............................................................... 139
Scanning is Slow ........................................................................... 140
Solving Network Scanning Problems ........................................... 141
Cannot Scan Over a Network ......................................................... 141
Scanner Cannot Connect to a Wireless Router ......................... 142
Solving Scanned Image Quality Problems ................................... 143
Back of Original Image Appears in Scanned Image .................... 144
Scanned Characters are Blurry ..................................................... 144
Characters are not Recognized During Conversion to Editable Text (OCR) ........................................................................ 145
Ripple Patterns Appear in an Image .............................................. 145
Spots or Lines Appear in All Scanned Images ............................ 146
Scanned Image is Cropped ............................................................ 146
Resetting the Epson Scan 2 Settings ........................................... 147
Uninstall Your Scanner Software ................................................ 147
Uninstalling Scanner Software - Windows ................................. 147
Uninstalling Scanner Software - Mac ....................................... 148
Where to Get Help ..................................................................... 149

Technical Specifications ..................................................................... 150
Windows System Requirements .................................................. 150
Mac System Requirements .......................................................... 150
General Specifications .................................................................. 151
Dimension Specifications ........................................................... 153
Electrical Specifications ................................................................ 154
Environmental Specifications ...................................................... 155
Network Interface Specifications (ES-300W/ES-300WR) ............ 156
Safety and Approvals Specifications ........................................... 156
For a printable PDF copy of this guide, click here.

If you have not already done so, you can download the Epson ScanSmart software for use with your scanner. Visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product. Then select the software on the Downloads tab.

For instructions on scanning with Epson ScanSmart, see the help information in Epson ScanSmart or click here to access the Epson ScanSmart User's Guide.
Scanner Basics

See these sections to learn about the basic features of your scanner.

- Scanner Parts Locations
- Changing the Power Save Settings
- Charging the Battery (ES-300W/ES-300WR)

Scanner Parts Locations

See these sections to identify the parts on your scanner.

- Scanner Parts
- Scanner Buttons and Lights
- User Replaceable Epson Scanner Parts and Accessories

Parent topic: Scanner Basics

Scanner Parts

Note: The illustrations show the ES-300W/ES-300WR, but the parts are the same for the ES-200.

1  Input tray
1. Output slot
2. Card slot
3. Mode selector
4. Edge guides
5. Paper guide
6. Input tray
7. Cover latch
7 ADF (Automatic Document Feeder)
8 Connection mode switch (ES-300W/ES-300WR only)

1 Power inlet
1 Scanner cover
2 Pickup roller
3 Separation pad

1 AC adapter
2 USB port
3 AC adapter
2 Power cord
3 SuperSpeed USB 3.0 cable

**Parent topic:** [Scanner Parts Locations](#)

**Scanner Buttons and Lights**

**ES-200**

1 🌐 power button
2 🚨 error light
3 📚 automatic feeding mode light
4 ⏪ stop button
5 Ready light
6 🔼 start button
ES-300W/ES-300WR

1  

2  error light

3  automatic feeding mode light

4  stop button

5  Ready light

6  start button

7  Wi-Fi connect button

8  Wi-Fi light

9  battery light

Parent topic: Scanner Parts Locations
User Replaceable Epson Scanner Parts and Accessories

You can purchase genuine Epson accessories at epson.com (U.S. sales), epson.ca (Canadian sales), or epson.com.jm (Caribbean sales). You can also purchase accessories from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

<table>
<thead>
<tr>
<th>Part</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pickup roller</td>
<td>B12B819251</td>
</tr>
<tr>
<td>Separation pad</td>
<td>B12B819271</td>
</tr>
</tbody>
</table>

Parent topic: Scanner Parts Locations

Changing the Power Save Settings

You can use the Epson Scan 2 Utility to change the time period before the scanner enters sleep mode and turns off automatically.

1. Do one of the following to access the Epson Scan 2 Utility:
   - **Windows 10**: Click and select EPSON > Epson Scan 2 Utility.
   - **Windows 8.x**: Navigate to the Apps screen and select Epson Scan 2 Utility.
   - **Windows (other versions)**: Click or Start, and select All Programs or Programs. Select EPSON > Epson Scan 2 > Epson Scan 2 Utility.
   - **Mac**: Open the Applications folder, open the Epson Software folder, and select Epson Scan 2 Utility.
2. Click the **Power Save** tab.

![Epson Scan 2 Utility](image)

3. Select the length of time after which you want the scanner to go to sleep as the **Sleep Timer** setting.
4. Select a power off timer setting for the **AC power or AC adapter** and **Battery or USB power** settings.
5. Close the Epson Scan 2 Utility.

**Parent topic:** [Scanner Basics](#)

---

### Charging the Battery (ES-300W/ES-300WR)

The scanner runs on battery power when it is connected to the computer with a USB cable or WiFi. You can charge the battery from a computer with a USB connection or by connecting a power cord and AC adapter to the scanner.
To charge the battery with the power cord, connect the power cord to the AC adapter, connect the AC adapter to the scanner, and then plug in the power cord.

The battery charging light turns orange while the battery is charging. When charging is complete, the light turns blue (if the scanner is on) or turns off (if the scanner is off).

**Note:** The battery takes about 3 hours to fully charge.

To charge the battery from a computer with a USB connection, follow these steps:
1. Make sure that the computer is on and not in sleep mode.
2. Connect the scanner to the computer using the micro USB cable.

3. Press the power button to turn on the scanner.

   The battery charging light turns orange while the battery is charging. When charging is complete, the light turns blue (if the scanner is on) or turns off (if the scanner is off).

   **Note:** Battery charging time when the scanner is on is about 4 hours when connected to a USB 3.0 port and about 20 hours when connected to a USB 2.0 port. Charging times increase if the scanner is off during the charging process.

**Parent topic:** Scanner Basics
Loading Originals

Follow the instructions here to load your originals into the scanner.

**Note:** The illustrations show the ES-300W/ES-300WR, but the steps are the same for the ES-200.

Loading Originals in the Input Tray
Loading Receipts in the Input Tray
Loading Special Originals
Loading Plastic Cards in the Card Slot

**Loading Originals in the Input Tray**

You can load originals that meet the document specifications in the input tray.

1. Slide the cover latch to open the scanner.
2. Press the power button to turn on the scanner, if necessary.
3. Extend the paper guide.

**Note:** If you are loading an original that is 14.5 inches (368.3 mm) or longer, do not extend the paper guide.
4. Raise the input tray edge guides and slide them all the way out.

5. If you are loading a multi-page original, fan your stack of originals.

**Note:** If you are loading an original that is 14.5 inches (368.3 mm) or longer, load only one sheet at a time.
6. Stack the originals with the printed side facing down and slide the stack so the leading edge is at an angle as shown.
7. Slide the mode selector to ADF and load standard originals into the input tray printed side down and top edge first. Slide in the originals until they meet resistance and the ready light becomes brighter.
8. Slide the edge guides against the edges of the original.

**Note:** If you are scanning originals that are 14.5 inches (368.3 mm) or longer, support the original as it enters into and ejects from the scanner as shown.
# Original Document Specifications

You can load original documents that meet these specifications in your scanner.

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Paper size</th>
<th>Paper weight</th>
<th>Loading capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>14 to 34 lb (52 to 128 g/m²)</td>
<td>17 lb (64 g/m²): 25 sheets</td>
</tr>
<tr>
<td></td>
<td>Legal (8.5 × 14 inches [216 × 356 mm])</td>
<td>1 sheet</td>
<td>21 lb (80 g/m²): 20 sheets</td>
</tr>
<tr>
<td></td>
<td>A4 (8.3 × 11.7 inches [210 × 297 mm])</td>
<td></td>
<td>34 lb (128 g/m²): 12 sheets</td>
</tr>
<tr>
<td></td>
<td>A5 (5.8 × 8.2 inches [148 × 210 mm])</td>
<td>Loading capacity may</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A6 (4.1 × 5.8 inches [105 × 148 mm])</td>
<td>vary depending on the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>B5 (7.2 × 10.1 inches [182 × 257 mm])</td>
<td>paper type.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>B6 (5 × 7.2 inches [128 × 182 mm])</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Width: 2.0 to 8.5 inches (50.8 to 215.9 mm)</td>
<td>14 to 34 lb (52 to 128 g/m²)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Height: 14.5 to 44 inches (368.3 to 1117.6 mm) (For receipts scanned using Epson ScanSmart [ES-300WR], see the link below.)</td>
<td>1 sheet</td>
<td></td>
</tr>
</tbody>
</table>
Caution: Do not load the following types of originals in the scanner, or they may be damaged or may damage the scanner:

- Photos
- Thermal paper
- Coated paper
- Glossy originals
- Fabric or other non-paper originals
- Originals with uneven surfaces, such as embossed documents
- Originals containing staples or paper clips
- Originals with carbon paper backing
- Originals with wet ink
- Originals that are bound
- Originals with labels, stickers, or sticky notes
- Ripped, curled, or wrinkled originals
- Originals with holes, other than standard hole-punched originals
- Transparencies
- Carbon-less paper
- Perforated originals

Parent topic: Loading Originals in the Input Tray
Related references
Receipt Specifications
Loading Receipts in the Input Tray

You can load receipts that meet the specifications in the input tray.

**Note:** Load only one receipt at a time.

1. Slide the cover latch to open the scanner.

**Note:** Do not extend the paper guide.
2. Press the power button to turn on the scanner, if necessary.

3. Start the Epson Scan 2 program, select the **Automatic Feeding Mode** checkbox on the Main Settings tab, then click **Scan**.

   The Automatic Feeding Mode light on the scanner turns on.
Note: Make sure to specify the correct Document Size in Epson Scan 2. If the receipt length is 34 inches (863.6 mm) or less, select **Auto Detect (Long Paper)** to detect the size automatically. If the receipt length is more than 34 inches (863.6 mm), select **Customize** and enter the paper size.

4. Raise the input tray edge guides and adjust them to the width of the receipt.
5. Slide the mode selector to ADF and load the receipt into the input tray printed side down and top edge first.
6. Guide the receipt into the ADF and support it as it enters automatically into the scanner. (You can continue feeding receipts into the scanner, one after another, while the scanner is in Automatic Feeding Mode.)

7. When you are finished scanning, press the stop button on the scanner to close Automatic Feeding Mode.

Receipt Specifications
Parent topic: Loading Originals
Related references
Receipt Specifications
Related topics
Scanning
Receipt Specifications

You can load 1 receipt at a time that meets these specifications in your scanner.

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Paper size</th>
<th>Paper thickness</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receipts (plain paper, fine paper, or recycled paper)</td>
<td>3 × 3 inches (76.2 × 76.2 mm) to 3 × 14 inches (76.2 × 355.6 mm)</td>
<td>14 to 20 lb (53 to 77 g/m²)</td>
</tr>
<tr>
<td></td>
<td>With Epson ScanSmart (ES-300WR):</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Receipts scanned at 301 dpi or more: up to 8.5 × 15.5 inches (215.9 × 393.8 mm)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Receipts scanned at 300 dpi or less: up to 3.14 × 26 inches (79 × 660 mm) at a width of 3.14 inches (79 mm) or less</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Receipts scanned at 300 dpi or less: up to 8.5 × 36 inches (215.9 × 914.4 mm) at a width of 3.15 inches (80 mm) or more</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Scan receipts one at a time using Automatic Feeding Mode. Support a long original receipt as it enters and exits the scanner.

**Parent topic:** Loading Receipts in the Input Tray

Loading Special Originals

You can load envelopes or thick originals (such as post cards or business cards) in the input tray. Make sure the originals meet the specifications for special originals before loading them.

**Note:** When scanning special originals, turn off the Detect Double Feed setting on the Main Settings tab in Epson Scan 2.
1. Slide the cover latch to open the scanner.

2. Press the power button to turn on the scanner, if necessary.
3. Extend the paper guide.
4. Raise the input tray edge guides and slide them all the way out.

5. Slide the mode selector to ADF.
6. Do one of the following:
   • For an envelope, load it vertically in the input tray with the printable side down and the flap facing as shown. Slide in the envelope until it meets resistance and the ready light becomes brighter.
• For thick originals, load them vertically in the input tray printable side down and top edge first. Slide in the originals until they meet resistance and the ready light becomes brighter.
7. Slide the edge guides against the edges of the original.

Special Original Specifications

Parent topic: Loading Originals

Related references
Special Original Specifications

Related topics
Scanning

Special Original Specifications
You can load envelopes or thick originals (such as post cards or business cards) that meet these specifications in your scanner.

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Paper size</th>
<th>Paper thickness</th>
<th>Loading capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Envelopes</td>
<td>4.72 × 9.25 inches (120 × 235 mm)</td>
<td>0.015 inch (0.38 mm) or less</td>
<td>1 envelope</td>
</tr>
<tr>
<td></td>
<td>3.62 × 6.50 inches (92 × 165 mm)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Loading Plastic Cards in the Card Slot

You can load plastic cards that meet the card specifications in the card slot.

**Note:** Do not load plastic cards into the ADF.

1. Slide the cover latch to open the scanner.
2. Press the power button to turn on the scanner, if necessary.

3. Slide the mode selector to card.
4. Load the card into the card slot face up and top edge first until the leading edge of the card is pulled into the scanner. Make sure to insert the card according to the white guidelines on the card slot.
Note: Do not load plastic cards horizontally or at an angle.

When scanning starts, the card is taken into the scanner, protrudes slightly from the slot at the back, and then returns through the scanner and ejects from the card slot at the front. Do not touch the card until it is fully ejected or a malfunction may occur.

Plastic Card Specifications

Parent topic: Loading Originals
Plastic Card Specifications

You can load original plastic and laminated cards that meet these specifications in your scanner's card slot.

<table>
<thead>
<tr>
<th>Card type</th>
<th>Card size</th>
<th>Card thickness</th>
<th>Loading capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plastic cards, standard (ISO7810 ID-1 compliant)</td>
<td>2.1 × 3.3 inches (54 × 85.6 mm)</td>
<td>0.04 inch (1.0 mm) or less</td>
<td>1 card (vertical)</td>
</tr>
</tbody>
</table>

Note: Plastic cards with glossy surfaces, laminated cards, and embossed cards may not scan properly.

Parent topic: Loading Plastic Cards in the Card Slot
Wi-Fi Networking

See these sections to use your scanner over a Wi-Fi network (ES-300W/ES-300WR).

Network Security Recommendations
Connection Mode Switch
Connecting to an Existing Wi-Fi Network
Epson DocumentScan App for iOS/Android
Restoring Default Network Settings
Connecting to a New Wi-Fi Router or Network

Network Security Recommendations

To help deter unauthorized access to your product over a network, you should protect your network environment using appropriate security measures.

Security measures such as these can help deter threats such as loss of user data, use of telephone and fax lines, and other intrusions:

• **Enable security on your wireless LAN**
  
  Enable the appropriate security on the wireless LAN you plan to use with your product. Network security such as a network password can deter interception of traffic over the wireless LAN. Your router may already have a default password enabled by your Internet service provider (ISP). See your ISP and router documentation for instructions on how to change the default password and better secure your network.

• **Connect your product only to a network protected by a firewall**
  
  Connecting your product directly to the Internet may leave it vulnerable to security threats. Instead, connect it to a router or other network connection protected by a firewall. Your router may already have a firewall set up by your Internet service provider; check with your ISP for confirmation. For best results, set up and use a private IP address for your network connection.

• **Change the default administrator password on your product**
  
  If your product has an option to set an administrator password, change the default administrator password to deter access by unauthorized users to personal data stored on your product, such as IDs, passwords, and contact lists.

**Parent topic:** Wi-Fi Networking
Connection Mode Switch

The position of the connection mode switch determines which method you can use to connect the scanner to a wireless network or device, or to a computer.

<table>
<thead>
<tr>
<th>Connection mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wi-Fi</td>
<td>Connects to a Wi-Fi router (requires additional network setup steps, see link at end of topic)</td>
</tr>
<tr>
<td>AP mode</td>
<td>Creates a local Wi-Fi network that allows other devices to connect directly to the scanner</td>
</tr>
<tr>
<td>USB</td>
<td>Connects to a computer via a USB cable</td>
</tr>
</tbody>
</table>

Parent topic: Wi-Fi Networking
Connecting to an Existing Wi-Fi Network

You can set up your scanner to communicate with your computer using a wireless router. The wireless router can be connected to your computer over a wireless or wired network.

1 Epson scanner
2 Wireless router
3 Computer with a wireless interface
4 Computer
5 Internet
6 Ethernet cable (used only for wired connection to the wireless router)

Manually Connecting to a Wi-Fi Network
Wi-Fi Protected Setup (WPS)
Setting Up Network Scanning
Manually Connecting to a Wi-Fi Network

You can manually connect the scanner to a Wi-Fi network by entering the network names (SSIDs) and passwords for your wireless network router and your scanner (ES-300W/ES-300WR). You must have a computer with a wireless adapter to set up the connection. Also make sure you have installed your scanner software as described on your scanner Start Here sheet.

**Note:** For best results, re-install your scanner software and follow the on-screen instructions to connect to a network.

1. Turn your scanner over and locate the label on the bottom listing the SSID and password for your scanner. Make a note of the SSID and password for use later.
2. Set the connection mode switch on the side of the scanner to the AP mode position.
3. Turn on the scanner and wait for the lights to stop flashing.
4. From your computer or device, open the list of wireless networks and select the SSID shown on the scanner label. Then select the connect option.
5. Enter the password shown on the scanner label.
6. Connect your computer or device to your wireless network router.
7. Set the connection mode switch on the side of the scanner to the Wi-Fi position.

Wait for the ready and Wi-Fi lights on the scanner to stop flashing and stay on, indicating that the scanner is connected to the network.

8. Select the link below to set up network scanning. You must set up network scanning to connect your computer and wireless scanner.

Parent topic: Connecting to an Existing Wi-Fi Network

Related tasks
Setting Up Network Scanning

Wi-Fi Protected Setup (WPS)

If your network uses a WPS-enabled wireless router, you can quickly connect your scanner to the network using Wi-Fi Protected Setup (WPS).

Note: To check if your router is WPS-enabled, look for a button labeled WPS on your router. If there is no hardware button, there may be a WPS setting in the software for the device. Check your network product documentation for details.
Using WPS to Connect to a Network

Using WPS PIN Mode to Connect to a Network

Parent topic: Connecting to an Existing Wi-Fi Network

Using WPS to Connect to a Network

If you have a WPS-enabled wireless router, you can use Wi-Fi Protected Setup (WPS) to connect your scanner to the network (ES-300W/ES-300WR). Make sure you have installed your scanner software as described on your scanner Start Here sheet.

Note: For best results, re-install your scanner software and follow the on-screen instructions to connect to a network.

1. Set the connection mode switch on the scanner to the Wi-Fi position.

2. Enable WPS on your router by pressing and holding the WPS button until the security light flashes or by enabling the WPS setting in your router firmware.

   The router enters WPS discovery mode for 2 minutes.

   Note: If you cannot locate the WPS button, or there are no buttons on the router, see the documentation provided with your router for details.
3. Turn on the scanner.
4. Press and hold the Wi-Fi connect button on the scanner for at least 3 seconds, then release it when the ready and Wi-Fi lights flash alternately.

**Note:** If you do not complete this step within 2 minutes, repeat steps to try again.

When the ready and Wi-Fi lights on the scanner stay on, the scanner is connected to the network.

**Note:** If the ! error light turns on, the connection failed. Press the stop button to clear the error, restart the scanner and router, and repeat these steps.

5. Select the link below to set up network scanning. You must set up network scanning to connect your computer and wireless scanner.

**Parent topic:** Wi-Fi Protected Setup (WPS)
Using WPS PIN Mode to Connect to a Network

If you have a WPS-enabled wireless router that supports PIN mode, you can use Wi-Fi Protected Setup (WPS) PIN mode to connect your scanner to the network (ES-300W/ES-300WR). Make sure you have installed your scanner software as described on your scanner Start Here sheet.

Note: For best results, re-install your scanner software and follow the on-screen instructions to connect to a network.

1. Find the WPS PIN number setting in your router's firmware.
2. Make sure the scanner is turned off.
3. Slide the cover latch to open the scanner.
4. Set the connection mode switch on the side of the scanner to the AP mode position.
5. Press and hold the Wi-Fi connect button as you press the power button to turn on the scanner. Release the Wi-Fi connect button when the ready and Wi-Fi lights flash alternately.

Note: The scanner enters WPS discovery mode for 2 minutes.

6. Use your computer to enter the PIN code 01234565 into the WPS PIN number setting in the wireless router within two minutes.

The ready and Wi-Fi lights on the scanner stay on, indicating that the scanner is connected to the network.

Note: If you do not enter the code within 2 minutes, repeat steps 1 through 6.

7. Turn off the scanner.
8. Set the connection mode switch on the scanner to the Wi-Fi position.

9. Press the power button to turn on the scanner.
   When the ready and Wi-Fi lights on the scanner stay on, the scanner is connected to the network.

   **Note:** If the ! error light turns on, the connection failed. Press the stop button to clear the error, restart the router, and repeat these steps.

10. Select the link below to set up network scanning. You must set up network scanning to connect your computer and wireless scanner.

    **Parent topic:** Wi-Fi Protected Setup (WPS)

    **Related tasks**
    Setting Up Network Scanning

**Setting Up Network Scanning**

After manually configuring your scanner to connect to your network, you must set up the computer to connect to the scanner using the Epson Scan 2 Utility. Your scanner must be turned on and connected to the network before you begin.
Note: Make a note of the IP address or host name of the scanner so you can enter it in these steps.

1. Do one of the following to start the Epson Scan 2 Utility:
   - **Windows 10**: Click and select EPSON > Epson Scan 2 Utility.
   - **Windows 8.x**: Navigate to the Apps screen and select Epson Scan 2 Utility.
   - **Windows (other versions)**: Click or Start, and select All Programs or Programs. Select EPSON > Epson Scan 2 > Epson Scan 2 Utility.
   - **Mac**: Open the Applications folder, open the Epson Software folder, and select Epson Scan 2 Utility.

2. Select **Settings** from the Scanner drop-down list.
   You see a screen like this:

   ![Scanner Settings Screen](image)

   Note: If you see an **Enable Editing** button (Windows) or a lock icon (Mac), click it so that you can modify the scanner settings.

3. Select your scanner and click **Add**.
4. Do one of the following:
   • Under **Search for Network**, select the IP address of your scanner and click **Add**.
   • Select the **Enter address** setting, type in the IP address or host name of your scanner, and click **Add**.

5. Click **OK** to save your settings and then close Epson Scan 2 Utility.

Determining the Scanner’s IP Address

Parent topic: Connecting to an Existing Wi-Fi Network

### Determining the Scanner's IP Address

If you have multiple scanners on your network, you need to know the IP address of the scanner when setting up network scanning.
1. Do one of the following to start EpsonNet Config:
   - **Windows 10**: Click 🔄 > EpsonNet > EpsonNet Config.
   - **Windows 8.x**: Navigate to the Apps screen and select EpsonNet Config.
   - **Windows (other versions)**: Click ☐️ or Start, and select All Programs or Programs. Select EpsonNet > EpsonNet Config > EpsonNet Config.
   - **Mac**: Open the Applications folder and select Epson Software > EpsonNet > EpsonNet Config > EpsonNet Config.

2. Locate your scanner in the list and write down the IP address.

**Parent topic:** Setting Up Network Scanning

---

### Epson DocumentScan App for iOS/Android

You can use the Epson DocumentScan app to scan from a network scanner to an iOS or Android device over a direct Wi-Fi connection (ES-300W/ES-300WR).

For more information about Epson DocumentScan, search for the app on the App Store (iOS) or Google Play (Android).

**Parent topic:** Wi-Fi Networking

### Restoring Default Network Settings

If you need to solve a problem with your network connection, you can restore all network settings to their defaults (ES-300W/ES-300WR).
1. Set the connection mode switch on the scanner to the Wi-Fi position.
2. Press and hold the Wi-Fi connect button and press the power button to turn on the scanner.

3. Hold the Wi-Fi connect button until the ready and Wi-Fi lights on the scanner flash alternately.

4. Turn off the scanner.

   The default network settings are restored.

Parent topic: Wi-Fi Networking

Connecting to a New Wi-Fi Router or Network

If you change your wireless router or network, you need to update your product's Wi-Fi connection. You can also follow these steps to select a different connection method, such as a USB connection, instead of a wireless network connection.

Note: If you switch to a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation for instructions.

1. Download and install your product software from the Epson website.
   You see a window like this:

   ![Install Software window](image)

   2. Select **Set up scanner connection again**, click **Next**, and follow any on-screen instructions to select your connection method.

   **Parent topic:** Wi-Fi Networking
Scanning

You can scan your originals and save them as digital files.

Note: For instructions on scanning with Epson ScanSmart, see the help information in Epson ScanSmart or click here to access the Epson ScanSmart User's Guide.

Starting a Scan
Scanning with Document Capture Pro in Standard View
Scanning with Document Capture Pro in Simple View
Scanning with Document Capture - Mac
Scanning in Epson Scan 2
Scan Resolution Guidelines
Scanning Special Projects

Starting a Scan

After placing your originals on your product for scanning, start scanning using one of these methods.

Note: For instructions on scanning with Epson ScanSmart, see the help information in Epson ScanSmart or click here to access the Epson ScanSmart User's Guide.

Starting a Scan from a Scanner Button
Starting a Scan Using the Epson Scan 2 Icon
Starting a Scan from a Scanning Program

Parent topic: Scanning

Starting a Scan from a Scanner Button

You can scan using the start button on your scanner. This automatically starts Document Capture Pro (Windows) and Document Capture (Mac) and the scan job you have assigned to the button.

Note: If you installed the Epson ScanSmart software, pressing the start button on your scanner starts Epson ScanSmart instead. For instructions on scanning with Epson ScanSmart, see the help information in Epson ScanSmart or click here to access the Epson ScanSmart User's Guide.
Note: If you did not install Epson ScanSmart, make sure Epson Scan 2 and Document Capture Pro (Windows) or Document Capture (Mac) are installed on the computer connected to the scanner. Document Capture Pro (Windows) and Document Capture (Mac) do not support scanning from the start button on your scanner over a wireless network (ES-300W/ES-300WR). Launch Epson Scan 2 before scanning from the start button on your scanner.

1. Make sure the scanner is connected to your computer or network (ES-300W/ES-300WR).
2. If you are scanning using the ADF, slide the mode selector to ADF. If you are scanning a business or plastic card using the card slot, slide the mode selector to card.
3. Load an original in your scanner.
4. Press the start button.
   The scanner starts the job that was assigned to the start button in Document Capture Pro (Windows) or Document Capture (Mac).

Note: You can view or change the scan settings using Document Capture Pro (Windows) or Document Capture (Mac).

Adding and Assigning Scan Jobs with Document Capture Pro - Windows
Assigning Start Button Settings or Scan Jobs - Mac
Parent topic: Starting a Scan
Related topics
Loading Originals

Adding and Assigning Scan Jobs with Document Capture Pro - Windows
You can view, change, or add available default scan settings when you scan using the start button on your product. You do this by accessing the scan jobs in the Document Capture Pro program.

Note: The settings may vary, depending on the software version you are using. See the help information in Document Capture Pro for details.

1. Do one of the following to start Document Capture Pro:
   - **Windows 10:** Click and select Epson Software > Document Capture Pro.
   - **Windows 8.x:** Navigate to the Apps screen and select Document Capture Pro.
   - **Windows (other versions):** Click Start, and select All Programs or Programs. Select Epson Software > Document Capture Pro.
You see the Document Capture Pro window.

2. If you see a **Switch to Simple View** button in the upper right corner of the window, click it.

   You see a window like this:

   ![Switch to Simple View window](image)

3. Click the **Job Settings** button.

   **Note:** If you do not see the button, click the `<` symbol in the **Job** bar.
You see a window like this:

![Window](image)

4. To add a scan job, click the **New Job** icon, enter a name for the new job, select settings as necessary, and click **OK**.

   You can now use the new scan job when you scan with Document Capture Pro.

   **Note:** See the Help information in Document Capture Pro for details.

5. To assign a scan job to the ✰ start button, click the **Button Assignment** icon.

6. Select the job that you want to assign to the ✰ start button from the ✰ drop-down list.

7. Click **OK**, then click **OK** again.

   You can now use the assigned scan job when you scan with the ✰ start button on your product.

**Parent topic:** Starting a Scan from a Scanner Button

Assigning Start Button Settings or Scan Jobs - Mac

You can view or change the default scan settings when you scan using the ✰ start button on your scanner. You do this by accessing the scan jobs in the Document Capture program.
Note: If you installed the Epson ScanSmart software, pressing the start button on your scanner starts Epson ScanSmart instead. For instructions on scanning with Epson ScanSmart, see the help information in Epson ScanSmart or click here to access the Epson ScanSmart User’s Guide.

Note: If you did not install Epson ScanSmart, Document Capture Pro (Windows) and Document Capture (Mac) do not support scanning from the start button on your scanner over a wireless network (ES-300W/ES-300WR). Launch Epson Scan 2 before scanning from the start button on your scanner.

1. Start Document Capture on a computer connected to the product.

2. Click the Manage Job icon from the toolbar at the top of the window.
   You see a window showing the current scan job list.

3. If you want to add a scan job, click Add or the + icon, enter a name for the new job, select settings as necessary, and click OK.
   You can now use the new scan job when you scan with Document Capture.

   Note: See the Help information in Document Capture for details.

4. If you want to assign a scan job to the start button, click the icon at the bottom of the window and click Event Settings.
5. Select the job that you want to assign to the start button.

6. Click **OK**.

**Parent topic:** Starting a Scan from a Scanner Button

### Starting a Scan Using the Epson Scan 2 Icon

You can start the Epson Scan 2 program to select scan settings, scan, and save the scanned image to a file.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

- **Windows 10:** Click **Start** and select **EPSON > Epson Scan 2**.
- **Windows 8.x:** Navigate to the **Apps** screen and select **Epson Scan 2**.
- **Windows (other versions):** Click ![Start](image) or **Start**, and select **All Programs** or **Programs**. Select **EPSON > Epson Scan 2 > Epson Scan 2**.
- **Mac:** Open the **Applications** folder, open the **Epson Software** folder, and select **Epson Scan 2**.
You see an Epson Scan 2 window like this:
Starting a Scan from a Scanning Program

You can start Epson Scan 2 from a TWAIN-compliant scanning program to select scan settings, scan, and open the scanned image in the program.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

1. Open your scanning program and select its scanning option. (See your scanning program help for instructions.)
2. Select your product.

**Note:** In certain programs, you may need to select your product as the "source" first. If you see a **Select Source** option, choose it and select your product. With Windows, do not select a **WIA** option for your product; not all scan functions will be available.
You see an Epson Scan 2 window like this:
Scanning with Document Capture Pro in Standard View

You can use Document Capture Pro in Standard View to select settings, preview, and change the scanned file settings as necessary.

Note: The settings may vary, depending on the software version you are using. See the help information in Document Capture Pro for details.

1. Load your original in the product.
2. Do one of the following to start Document Capture Pro:
   • **Windows 10**: Click and select Epson Software > Document Capture Pro.
   • **Windows 8.x**: Navigate to the Apps screen and select Document Capture Pro.
   • **Windows (other versions)**: Click or Start, and select All Programs or Programs. Select Epson Software > Document Capture Pro.

   You see the Document Capture Pro window. (You may see a screen asking you to select your scanner first; if you do, select your product.)

3. If you see a Switch to Standard View button in the upper right corner of the window, click it.
   You see a window like this:
4. Select **Scan Settings** from the Scan Setting Name list (or select **Scan > Scan Settings** from the menu bar).

You see a window like this:

![Scan Settings window](image)

5. Select any displayed settings you want to use and click **OK**.

   **Note:** See the help information in Document Capture Pro for details.

6. Click **Scan**.
You see a preview of your scan in the Document Capture Pro window.

![Document Capture Pro window with a preview of a scanned page.]

**Note:** You may have to close the Epson Scan 2 window to view your scan in the Document Capture Pro window.

7. If you would like to scan additional originals and add them to the current captured images, click the **Add Page(s)** icon and follow the instructions on the screen.

8. Check the scanned images and edit them as necessary.

   **Note:** See the help information in Document Capture Pro for details.

9. Click one of the Destination icons to choose where to send your scanned files. (If you cannot see all of the icons below, click the arrows next to the icons.)

![Destination icons for sending scanned files.]

10. Depending on the destination you chose, click **OK** or **Send** to complete the scan.

**Parent topic:** Scanning
Related tasks
Scanning in Epson Scan 2
Related topics
Loading Originals

Scanning with Document Capture Pro in Simple View

You can use Document Capture Pro in Simple View to quickly select options and scan.

**Note:** The settings may vary, depending on the software version you are using. See the help information in Document Capture Pro for details.

1. Load your original in the product.
2. Do one of the following to start Document Capture Pro:
   - **Windows 10:** Click  and select *Epson Software > Document Capture Pro*.
   - **Windows 8.x:** Navigate to the *Apps* screen and select *Document Capture Pro*.
   - **Windows (other versions):** Click  or *Start*, and select *All Programs* or *Programs*. Select *Epson Software > Document Capture Pro*.

   You see the Document Capture Pro window. (You may see a screen asking you to select your scanner first; if you do, select your product.)
3. If you see a **Switch to Simple View** button in the upper right corner of the window, click it.
You see a window like this:

4. Click **Select Scanner** and select your scanner from the scanner list, if necessary.

5. If you want to use a scan job, click one of the job icons in the **Job** section of the window to complete and send your scan with one click.

   **Note:** If you do not see any icons, click the **V** symbol next to the **Job Settings** button.
6. If you want to select scan settings for a particular destination, click the **Scan Settings** button, select any displayed settings you want to use, and click **OK**.

   **Note:** See the help information in Document Capture Pro for details. If you do not see the **Scan Settings** button, click the `<` symbol in the **Scan and...** bar.

![Scan Settings window](image)

7. Click one of the destination icons in the **Scan and...** section of the window. Your product starts scanning and you see the settings window.

8. Select any destination settings as necessary and click **OK**.

   **Note:** See the help information in Document Capture Pro for details.

9. Confirm your settings and click **OK** or **Close**.

**Parent topic:** [Scanning](#)
Related tasks
Scanning in Epson Scan 2
Related topics
Loading Originals

**Scanning with Document Capture - Mac**

When you scan with Document Capture, the program automatically saves your scanned file on your computer in the folder you specify. You can select settings, preview, and change the scanned file settings as necessary.

**Note:** Settings may vary depending on the software version you are using. See the Help menu in Document Capture at any time for more information.

1. Load your original in the product.
2. Open the **Applications** folder, open the **Epson Software** folder, and select **Document Capture**.
   You see a window like this:

   ![Document Capture Window](image)

   **Note:** You may need to select your scanner from the scanner list.

3. Click the **Scan** icon.
You see a window like this:

![Scan Settings window](image)

**Note:** If you want to use a scan job that you created instead, select it from the Job list in the Document Capture window, click the Start Job button, and skip the rest of these steps.

4. Select any displayed scan settings you want to use.

**Note:** See the Help information in Document Capture for details.

5. If you want to select detailed scan settings, close the Scan Settings window, open the **Scan** menu at the top of the Mac desktop, and select **Displays the EPSON Scan Setup Screen.**

6. Click the **Scan** icon and select any detailed scan settings you want to use from the Epson Scan 2 window.

7. Click **Scan.**
You see a preview of your scan in the Document Capture window.

Note: You may have to close the Epson Scan 2 window to view your scan in the Document Capture window.

8. If you would like to scan additional originals and add them to the current captured images, click the + icon, select Acquire from Scanner, and repeat the previous steps.

9. Check the scanned images and edit them as necessary.

10. Click one of the destination icons to choose where to send your scanned files. (If you cannot see all of the icons below, click the arrow next to the icons.) Change any settings as necessary.

Note: If you are sending the scanned image to a server or cloud destination, you need to enter your login information.

11. Depending on the destination you chose, click OK or Send to complete the operation.

Parent topic: Scanning
Related tasks
Scanning in Epson Scan 2

Related topics
Loading Originals

Scanning in Epson Scan 2

Epson Scan 2 gives you access to basic and advanced scanning features. You can scan your document and save the scanned image in various file formats in your operating system’s Documents or My Documents folder, or open it in your scanning program. You can preview the scanned image and select or change settings as necessary.

1. Load your original in the product.
2. Start Epson Scan 2.
You see this window:
3. If you want to scan different size originals by loading them into the ADF one by one, check the **Automatic Feeding Mode** checkbox and click **Scan**. Scanning begins as soon as you load each original.

4. Select the **Scanning Side** setting that matches the sides of the original that you want to scan.

5. Select the **Document Size** setting that matches the size of your original, or select **Auto Detect** to have Epson Scan 2 automatically detect the size. You can select **Customize** to enter a custom size, if necessary.

6. Select your original image type and how you want it scanned as the **Image Type** setting.

7. Select the **Resolution** setting you want to use for your scan.

8. Select any of the additional settings that you want to use on the **Main Settings** tab.

9. Click the **Advanced Settings** tab and select any settings that you want to use.

10. If you are scanning using the ADF, slide the mode selector to **ADF**. If you are scanning using the card slot, slide the mode selector to **Card**.

11. To see a preview of your scan with the settings you selected, click the **Preview** button.

**Note:** The **Document Source** setting is automatically set to **ADF** for your product.
Epson Scan 2 previews your original and displays the results in the Epson Scan 2 window.

12. Reinsert your original into the ADF or card slot.
13. Select the format in which you want to save your scanned file as the **Image Format** setting. If necessary, select **Options** and select any desired format options.
14. Select **Settings** to modify the file name settings. Enter the file name for your scanned file in the **File Name** field.
15. Select the location in which you want to save your scanned file as the **Folder** setting. If necessary, select **Select** to choose an alternate folder or create a new folder.
16. Click **Scan**.
   The product scans your original and saves the scanned file in the location you specified.

17. If you selected the **Automatic Feeding Mode** setting, place your next original in the ADF for scanning. When you finish scanning originals, click **Finish**.

Additional Scanning Settings - Main Settings Tab
Additional Scanning Settings - Advanced Settings Tab
Scanning Settings for Special Documents
Image Format Options

Parent topic: Scanning
Related topics
Loading Originals

**Additional Scanning Settings - Main Settings Tab**

You can select these additional scanning settings on the Epson Scan 2 Main Settings tab.

**Stitch Images**
When scanning double-sided originals, lets you lay out images from both sides of the original onto one scanned page.

**Rotate**
Rotates the original image clockwise to the desired angle before scanning it. Select **Auto** to allow your product to automatically rotate the image based on the orientation of the text (may take longer to scan).

**Correct Document Skew**
Corrects skewed originals, image contents, or both.

**Add or edit pages after scanning**
Lets you add, remove, or edit the pages in a scan, including rotating pages and changing the page order.

**Note:** To save multiple pages in a single file, you must select a file format that supports multiple pages such as **PDF** or **Multi-TIFF**. If you select another file format, each scanned image or page is saved as a separate file.

**Skip Blank Pages**
If the scanner detects marks from the other side of a blank page and adds the marks to the scanned image, adjust this setting to prevent this.
Detect Double Feed
Detects a double-feed paper error in the ADF. If you are scanning an original envelope or plastic card, select Off.

Parent topic: Scanning in Epson Scan 2
Additional Scanning Settings - Advanced Settings Tab

You can select these additional scanning settings on the Epson Scan 2 Advanced Settings tab. Not all adjustment settings may be available, depending on other settings you have chosen or your scanner's features.
Remove Background
Removes the background from your originals.

Text Enhancement
Sharpens the appearance of letters in text documents.

Auto Area Segmentation
Makes black and white images clearer and text recognition more accurate by separating the text from the graphics.

Dropout
The scan will not pick up the color you select. This setting is available only if you select Grayscale or Black & White as the Image Type setting.

Color Enhance
Enhances the shades of the color you select in the scanned image. This setting is available only if you select Grayscale or Black & White as the Image Type setting.

Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.

Gamma
Adjusts the midtone density of the scanned image.

Threshold
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in OCR (Optical Character Recognition) programs.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.

Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This option improves results when scanning magazines or newspapers. (The results of descreening do not appear in the preview image, only in your scanned image.)

Edge Fill
Corrects shadowing around the edges of the image by filling the shadows with black or white.

Remove Punch Holes
Removes the shadows caused by holes on the edges of the original.

Dual Image Output
Scans the original image twice using different output settings (Windows only).
Parent topic: Scanning in Epson Scan 2

Scanning Settings for Special Documents

You need to select specific options on the Main Settings tab in Epson Scan 2 when scanning special originals.

<table>
<thead>
<tr>
<th>Type of original</th>
<th>Required settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Envelope</td>
<td>Select Off as the Detect Double Feed setting and Auto as the Rotate setting.</td>
</tr>
<tr>
<td>Plastic cards</td>
<td>Select Plastic Card as the Document Size setting and Off as the Detect Double Feed setting.</td>
</tr>
<tr>
<td>Large originals</td>
<td>If the Document Size list does not contain the document size you want to scan, select Customize to create a custom size.</td>
</tr>
<tr>
<td>Long paper</td>
<td>If the Document Size list does not contain the document size you want to scan, select Auto Detect (Long Paper) or select Customize to create a custom document size up to 44 inches (1117.6 mm).</td>
</tr>
<tr>
<td>Receipts (ES-300WR)</td>
<td>If the receipt length is 34 inches (863.6 mm) or less, select Auto Detect (Long Paper) to detect the size automatically. If the receipt length is more than 34 inches (863.6 mm), select Customize to create a custom document size up to 44 inches (1117.6 mm).</td>
</tr>
</tbody>
</table>

Parent topic: Scanning in Epson Scan 2

Image Format Options

You can select different image formats and related options. For details on available options, click the ? icon on the Epson Scan 2 Image Format Options window. Not all image formats have options.

**BITMAP (*.bmp)**

A standard image file format for most Windows programs.

**JPEG (*.jpg)**

An image format that lets you highly compress image data. However, the higher the compression, the lower the image quality. (The TIFF format is recommended when you need to modify or retouch your scanned image.)
**PNG (*.png)**
An image format that does not lose quality during editing.

**TIFF (*.tif)**
A file format created for exchanging data between many programs, such as graphic and DTP software.

**Multi-TIFF (*.tif)**
A TIFF file format when multiple pages are saved to the same file, allowing you to edit the images using a compatible program.

**PDF (*.pdf)**
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or other programs. You can save multi-page documents in one PDF file.

**Searchable PDF (*.pdf)**
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or other programs. You can save multi-page documents in one PDF file. Recognized text in the scanned document can be searched.

**Parent topic:** Scanning in Epson Scan 2

---

**Scan Resolution Guidelines**

The resolution setting in your scanning software, measured in dpi (dots per inch), controls the amount of detail captured in your scans. Increasing the resolution raises the amount of detail captured but comes with the following disadvantages:

- Larger file sizes
- It takes longer to scan your originals, send/receive your scans by email or fax, and to print your scans
- The image may become too large to fit on your display or print on paper

If you plan to enlarge a scanned image so you can print it at a larger size, you may need to increase the resolution from the default resolution set by the software. Follow these guidelines to determine the resolution setting you need:

- You will scan the image at its original size but enlarge it later in an image-editing program.
  
  Increase the resolution setting in your scanning software. Increase the resolution by the same amount you will increase the image size to retain a high image quality. For example, if the resolution is 300 dpi (dots per inch) and you will double the image size later, change the resolution setting to 600 dpi.

- You will scan the image at 100% or smaller size.
  
  Select the resolution setting based on how you will use the scanned image:

  - Email/view on a computer screen/post on the web: 96 to 200 dpi
• Print/fax/convert to editable text (OCR)/create searchable PDF: 200 to 300 dpi
• You will scan the image on long paper.
  Scan paper up to 44 inches (1117.6 mm) in length with a maximum resolution of 300 dpi or less.

Parent topic: Scanning

Scanning Special Projects

Your product's scanning software offers various options to help you quickly complete special scan projects.

Note: For instructions on scanning with Epson ScanSmart, see the help information in Epson ScanSmart or click here to access the Epson ScanSmart User’s Guide.

Scanning Two Originals onto One Sheet (Stitching Images)
Scanning Multi-Page Originals as Separate Files - Windows
Saving Scanned Documents as a Searchable PDF Using Epson Scan 2
Saving Scanned Documents as a Searchable PDF with Document Capture - Mac
Saving a Scan as an Office Format File - Windows
Saving a Scan as an Office Format File - Mac
Scanning to a SharePoint Server or Cloud Service - Windows

Parent topic: Scanning

Scanning Two Originals onto One Sheet (Stitching Images)

You can scan both sides of a double-sided or folded original and combine them into a single image with the Epson Scan 2 Stitch Images settings (not available for all products).

Note: The settings may vary, depending on the software version you are using. See the help information in Document Capture Pro for details.

1. Load your original in the product.
2. Do one of the following to start Document Capture Pro:

   • **Windows 10**: Click and select Epson Software > Document Capture Pro.
   • **Windows 8.x**: Navigate to the Apps screen and select Document Capture Pro.
• **Windows (other versions)**: Click 🔄 or Start and select All Programs or Programs. Select Epson Software > Document Capture Pro.

3. If you see a **Switch to Simple View** button in the upper right corner of the window, click it.

You see a window like this:

![Window with various icons]

4. Click the **Scan Settings** button, then click **Detailed Settings**.

   **Note**: If you do not see any icons, click the V symbol next to the Job Settings button.
You see an Epson Scan 2 window like this:
5. Select **Double-Sided** as the **Scanning Side** setting.
6. Select the original document size or **Auto Detect** as the **Document Size** setting.
7. Select one of the following as the **Stitch Images** setting:
   - **Top&Bottom**: Places the scanned images one above the other.
   - **Left&Right**: Places the scanned images side by side.
8. Select the **Advanced Settings** tab and set the **Edge Fill** setting to **None**.
9. Click **Save**.
10. Click **OK**.
11. Click **Scan**.
    The scanned image is displayed.

   **Note:** If the scanned images are not stitched together in the correct orientation, click **Scanning Side** on the Epson Scan 2 window, select **Settings**, set the Binding Edge to **Left** or **Top**, and rescan the document.

**Parent topic:** Scanning Special Projects

**Related topics**

Loading Originals

---

**Scanning Multi-Page Originals as Separate Files - Windows**

You can use Document Capture Pro (Windows) to scan multi-page originals as separate scanned files. You indicate how the separate files are created by defining a maximum page count per file or by inserting blank pages, barcodes, or characters that can be detected by the software as separation markers.

**Note:** The settings may vary, depending on the software version you are using. See the help information in Document Capture Pro for details.

1. Load your multi-page original in the product.
2. Do one of the following to start Document Capture Pro:
   - **Windows 10**: Click 📦 and select **Epson Software > Document Capture Pro**.
   - **Windows 8.x**: Navigate to the **Apps** screen and select **Document Capture Pro**.
• **Windows (other versions):** Click 📦 or Start, and select All Programs or Programs. Select Epson Software > Document Capture Pro.

You see the Document Capture Pro window.

3. If you see a **Switch to Simple View** button in the upper right corner of the window, click it.

You see a window like this:

![Simplified View of Document Capture Pro](image)

4. Click the **Scan Settings** button.

   **Note:** If you do not see any icons, click the V symbol next to the Job Settings button.
You see a window like this:

5. Select any displayed settings you want to use and click **OK**.
   
   **Note:** See the help information in Document Capture Pro for details.

6. Click one of the destination icons (except **Print**) in the **Scan and...** section of the window. Your product starts scanning and you see the settings window.

7. Select the **Apply job separation** checkbox.

8. Click **Separation Settings**.
You see a window like this:

9. Select the method you used to separate the originals as the Separator setting.

   **Note:** See the help information in Document Capture Pro for details.

10. If necessary, select **Create Folder** and select a folder name.
11. Select any other folder naming settings you want and click **OK**, then click **OK** again.

   Your originals are saved into separate files and folders as specified.

**Parent topic:** Scanning Special Projects
Saving Scanned Documents as a Searchable PDF Using Epson Scan 2

You can scan a document and save the text in a searchable PDF. In a searchable PDF, text is recognized using Optical Character Recognition (OCR) and then embedded in the scanned original.

**Note:** You must download and install the required Epson Scan 2 OCR Component to scan using OCR with Epson Scan 2. Select Epson Software Updater in the Windows Start menu or Mac Epson Software folder, and select the component and PDF extension files to download and install them.

1. If you are scanning using the ADF, slide the mode selector to ADF. If you are scanning using the card slot, slide the mode selector to card.
2. Load your original in the product for scanning.
3. Start Epson Scan 2.
4. Select your scan settings.
5. Click Preview and adjust the area you want to scan, if necessary.
6. Reload the ejected original in the scanner.
7. Select Searchable PDF as the Image Format setting.
8. Select Options from the Image Format list.
You see this window:

9. Select any of the options on the **General** tab.
10. Select the **Text** tab.
11. Make sure the language used in the document text is selected as the **Text Language** setting.
12. Click **OK**.
13. Confirm the **File Name** setting and select a **Folder** setting for your document.
14. Click **Scan**.

The scanned image is saved as a searchable PDF.

**Parent topic:** Scanning Special Projects

**Related topics**

Loading Originals
Saving Scanned Documents as a Searchable PDF with Document Capture - Mac

You can scan a document with Document Capture and save the text in a searchable PDF. In a searchable PDF, text is recognized using Optical Character Recognition (OCR) and then embedded in the scanned original.

**Note:** The settings may vary, depending on the software version you are using. See the Help information in Document Capture for details.

1. Load your original in the product for scanning.
2. Open the **Applications** folder, open the **Epson Software** folder, and select **Document Capture**.
   
   ![Document Capture window](image)

   **Note:** You may need to select your scanner from the scanner list.

3. Click the **Scan** icon.
You see a window like this:

![Scan Settings window](image)

**Note:** If you want to use a scan job that you created instead, select it from the Job list in the Document Capture window, click the Start Job button, and skip the rest of these steps.

4. Select any displayed scan settings you want to use.

**Note:** See the Help information in Document Capture for details.

5. If you want to select detailed scan settings, close the Scan Settings window, open the Scan menu at the top of the Mac desktop, and select **Displays the EPSON Scan Setup Screen**.

6. Click the Scan icon and select any detailed scan settings you want to use from the Epson Scan 2 window.

7. Click **Scan**.
You see a preview of your scan in the Document Capture window.

Note: You may have to close the Epson Scan 2 window to view your scan in the Document Capture window.

8. If you would like to scan additional originals and add them to the current captured images, click the + icon, select Acquire from Scanner, and repeat the previous steps.
9. Check the scanned images and edit them as necessary.
10. Open the File menu at the top of the Mac desktop and select Save As.
11. Select PDF as the File Type setting and click the Options button.
12. Select the Create Searchable PDF checkbox and click OK.
13. Click one of the Destination icons to choose where to send your scanned file. (If you cannot see all of the icons below, click the arrow next to the icons.)

14. Depending on the destination you chose, click OK or Send to complete the operation.
Saving a Scan as an Office Format File - Windows

You can use Document Capture Pro (Windows) to save your scans in one of the following Microsoft Office file formats: Microsoft Word (.docx), Microsoft Excel (.xlsx), or Microsoft PowerPoint (.pptx).

**Note:** The settings may vary, depending on the software version you are using. See the help information in Document Capture Pro for details.

1. Load your original in the product.
2. Do one of the following to start Document Capture Pro:
   - **Windows 10:** Click \ and select **Epson Software > Document Capture Pro.**
   - **Windows 8.x:** Navigate to the **Apps** screen and select **Document Capture Pro.**
   - **Windows (other versions):** Click \ or **Start**, and select **All Programs** or **Programs.** Select **Epson Software > Document Capture Pro.**
3. If you see a **Switch to Simple View** button in the upper right corner of the window, click it.

You see a window like this:
4. Click the **Scan Settings** button.

   **Note:** If you do not see any icons, click the V symbol next to the **Job Settings** button.

   You see a window like this:

   ![Scan Settings Window](image)

5. Select any displayed settings you want to use and click **OK**.

   **Note:** See the help information in Document Capture Pro for details.

6. Click one of the destination icons (except **Print**) to choose where to send your scanned files. Your product starts scanning and you see the settings window.

7. Select the Office format file you want to use from the **File Type** drop-down list.

   **Note:** The first time you select an Office format file you are prompted to download a plug-in update for Microsoft Office files. Select **Yes** to download and install the plug-in.
8. Click Option to display additional settings.

9. Select any additional settings as necessary and click OK.

Note: See the help information in Document Capture Pro for details.

10. Confirm your settings and click OK.

    Your originals are saved in the Office file format you selected.

Parent topic: Scanning Special Projects

Related topics

Loading Originals

Saving a Scan as an Office Format File - Mac

You can use Document Capture (Mac) to save your scans in one of these Microsoft Office file formats: Microsoft Word (.docx) and Microsoft Excel (.xlsx).

Note: The settings may vary, depending on the software version you are using. See the Help information in Document Capture for details.

1. Load your original in the product for scanning.

2. Open the Applications folder, open the Epson Software folder, and select Document Capture.
You see a window like this:

Note: You may need to select your scanner from the scanner list.

3. Click the **Scan** icon.
You see a window like this:

![Scan Settings window](image)

**Note:** If you want to use a scan job that you created instead, select it from the Job list in the Document Capture window, click the **Start Job** button, and skip the rest of these steps.

4. Select any displayed scan settings you want to use.

**Note:** See the Help information in Document Capture for details.

5. If you want to select detailed scan settings, close the Scan Settings window, open the **Scan** menu at the top of the Mac desktop, and select **Displays the EPSON Scan Setup Screen**.

6. Click the **Scan** icon and select any detailed scan settings you want to use from the Epson Scan 2 window.

7. Click **Scan**.
You see a preview of your scan in the Document Capture window.

Note: You may have to close the Epson Scan 2 window to view your scan in the Document Capture window.

8. If you would like to scan additional originals and add them to the current captured images, click the + icon, select Acquire from Scanner, and repeat the previous steps.

9. Check the scanned images and edit them as necessary.

10. Open the File menu at the top of the Mac desktop and select Save As.

11. Select DOCX (Word) or XLSX (Excel) as the File Type setting.

   Note: The first time you select an Office file type setting in Document Capture, you see a prompt to download a necessary plug-in for Microsoft Office files. Select Yes and follow the on-screen instructions to download and install the plug-in to continue.

12. Click the Options button, select any necessary Office file type options, and click OK.
13. Click one of the Destination icons to choose where to send your scanned file. (If you cannot see all of the icons below, click the arrow next to the icons.)

![Destination icons]

14. Depending on the destination you chose, click **OK** or **Send** to complete the operation.

**Parent topic:** Scanning Special Projects

**Related topics**

Loading Originals

**Scanning to a SharePoint Server or Cloud Service - Windows**

You can use Document Capture Pro to upload scanned images to a SharePoint server or a cloud service.

**Note:** The settings may vary, depending on the software version you are using. See the help information in Document Capture Pro for details.

1. Load your original in the product.
2. Do one of the following to start Document Capture Pro:
   - **Windows 10:** Click 📨 and select **Epson Software > Document Capture Pro**.
   - **Windows 8.x:** Navigate to the **Apps** screen and select **Document Capture Pro**.
   - **Windows (other versions):** Click 📦 or **Start**, and select **All Programs** or **Programs**. Select **Epson Software > Document Capture Pro**.
3. If you see a **Switch to Simple View** button in the upper right corner of the window, click it.
You see a window like this:

4. Click the **Scan Settings** button.

   **Note:** If you do not see any icons, click the V symbol next to the **Job Settings** button.
You see a window like this:

![Scan Settings window](image)

5. Select any displayed settings you want to use and click **OK**.

   **Note:** See the help information in Document Capture Pro for details.

6. Click one of the cloud server or service destination icons in the **Scan and...** section of the window. Your product starts scanning and you see the settings window.

   **Note:** If you cannot see all of the icons, the service software may not be installed or the service may not be available on your platform.

7. Enter any required information to set up the destination. You may need to log in to your cloud service to authenticate the connection and allow Document Capture Pro to access the cloud service. If you have previously created a saved setting for the destination, select it from the drop-down list.
8. Adjust any settings and click **OK**.

**Note:** See the help information in Document Capture Pro for details.

Your originals are uploaded to the indicated server or cloud service.

**Parent topic:** Scanning Special Projects

**Related topics**

Loading Originals
Cleaning and Transporting Your Scanner

See these sections if you need to clean or transport your scanner.

Cleaning Your Scanner
Cleaning Inside Your Scanner
Checking the Scanner Roller Counter
Replacing the Scanner Rollers
Transporting Your Scanner

Cleaning Your Scanner

To keep your product working at its best, you should clean it several times a year.

**Caution:** Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it. Do not use oil or other lubricants inside the product or let water get inside it. Do not open the product's outer case.

1. Turn off the scanner and unplug the AC adapter.
2. Disconnect any connected cables.
3. Clean the outer case with a soft, dry cloth. Do not use liquid or chemical cleansers.

**Note:** If the outer case still requires additional cleaning, use a slightly damp cloth to wipe the outer case. Then wipe the case with a soft, dry cloth.

Parent topic: Cleaning and Transporting Your Scanner

Cleaning Inside Your Scanner

Clean your scanner regularly to make sure that no dust builds up on the glass scanning surfaces. Dust can cause spots or lines in your scanned images.

**Note:** The illustrations show the ES-300W/ES-300WR, but the instructions are the same for the ES-200.

**Caution:** Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it. Do not use oil or other lubricants inside the product or let water get inside it.

1. Turn off the scanner and unplug the AC adapter.
2. Disconnect any connected cables.
3. Pull the edge of the scanner cover firmly at the arrow mark to open it.
4. Use a soft, moist cloth to wipe off any dust or dirt on the glass scanning surfaces and the rollers inside the scanner cover.

**Caution:** Do not spray glass cleaner directly on the scanning surfaces. Be careful not to place too much force on the glass.
5. Squeeze the tabs on the sides of the separation pad and pull up to remove it.

6. Use a soft cloth to wipe off any dust or dirt on the separation pad.
7. To replace the separation pad, slide it into the groove as shown and push it in until you hear it click into place.
8. Press the pickup roller cover latch and pull up the cover to remove it.
9. Slide the pickup roller to the right and lift up to remove it.

10. Wipe off any dust or dirt on the pickup roller using a soft, moist cloth.

    Caution: Use only a soft, moist cloth to clean the roller; using a dry cloth may damage the surface of the roller.
11. To replace the pickup roller, align the notch on the roller unit and slide it to the left. Press down to secure the roller.
12. Align the left edge of the pickup roller cover into the notches as shown and press it down until you hear it click into place.

![Diagram showing the alignment of the pickup roller cover]

**Note:** If you are not able to close the cover, the pickup roller is not installed correctly. Remove the roller unit and reinstall it, then try to close the cover again.

13. Plug in the AC adapter and press the ⚫ power button to turn on the scanner.

14. Hold down the ⚫ start button for at least two seconds while opening the scanner cover. The rollers on the bottom move momentarily, and then the scanner enters cleaning mode. Press the ⚫ start button again to start the cleaning process.
button several times to rotate the rollers shown here. Use a soft, moist cloth to wipe off any dust or dirt on the rollers as they rotate. Repeat this step until the rollers are clean.

15. Close the scanner cover. Press the edge of the scanner cover firmly at the arrow mark until the scanner cover clicks into place.

**Parent topic:** Cleaning and Transporting Your Scanner

### Checking the Scanner Roller Counter

Check the scanner roller counter to determine when your rollers need to be replaced. When you replace the scanner rollers, reset the scanner roller counter so you know when you may need to replace the rollers again.

1. Make sure the scanner is turned on and connected to your computer.
2. Do one of the following to open the Epson Scan 2 Utility:
   - **Windows 10**: Click and select **EPSON > Epson Scan 2 Utility**.
   - **Windows 8.x**: Navigate to the **Apps** screen and select **Epson Scan 2 Utility**.
   - **Windows (other versions)**: Click or **Start > All Programs or Programs > EPSON > Epson Scan 2 > Epson Scan 2 Utility**.
   - **Mac**: Open the **Applications** folder, click **Epson Software**, and click **Epson Scan 2 Utility**.

3. Click the **Counter** tab.
   You see a screen like this:

4. If the number in the **Number of Scans** field exceeds the number displayed as the **Life Cycle** of the rollers, it is time to replace the rollers.
5. Close the Epson Scan 2 Utility.

**Parent topic:** Cleaning and Transporting Your Scanner

**Replacing the Scanner Rollers**

Replace the scanner rollers when you see a replacement message displayed on your computer. Check the scanner roller counter to see when you need to replace the rollers.

**Note:** The illustrations show the ES-300W/ES-300WR, but the instructions are the same for the ES-200.

1. Turn off the scanner.
2. Unplug the AC adapter.
3. Disconnect any connected cables.
4. Pull the edge of the scanner cover firmly at the arrow mark to open it.
5. Press the pickup roller cover latch and pull up the cover to remove it.
6. Slide the pickup roller to the right and lift up to remove it.

7. To install the new pickup roller, align the notch on the roller unit and slide it to the left. Press down to secure the roller.
8. Align the left edge of the pickup roller cover into the notches as shown and press it down until you hear it click into place.

**Note:** If you are not able to close the cover, the pickup roller is not installed correctly. Remove the roller unit and reinstall it, then try to close the cover again.
9. Squeeze the tabs on the sides of the separation pad and pull up to remove it.
10. To install a new separation pad, slide it into the groove as shown and push it in until you hear it click into place.

11. Close the scanner cover. Press the edge of the scanner cover firmly at the arrow mark until the scanner cover clicks into place.

12. Plug in the AC adapter and turn on the scanner.

13. Reset the roller counter after replacing the rollers.

Resetting the Scanner Roller Counter

Parent topic: Cleaning and Transporting Your Scanner
Related references
User Replaceable Epson Scanner Parts and Accessories

Related tasks
Checking the Scanner Roller Counter
Resetting the Scanner Roller Counter

Resetting the Scanner Roller Counter

When you replace the scanner rollers, reset the scanner roller counter so you know when you may need to replace the rollers again.

1. Make sure the scanner is turned on and connected to your computer.
2. Do one of the following to open the Epson Scan 2 Utility:
   - **Windows 10**: Click and select **EPSON > Epson Scan 2 Utility**.
   - **Windows 8.x**: Navigate to the **Apps** screen and select **Epson Scan 2 Utility**.
   - **Windows (other versions)**: Click or **Start > All Programs or Programs > EPSON > Epson Scan 2 > Epson Scan 2 Utility**.
   - **Mac**: Open the **Applications** folder, click **Epson Software**, and click **Epson Scan 2 Utility**.
3. Click the **Counter** tab.
You see a screen like this:

4. Click Reset.
   The Number of Scans field changes to 0 (zero).
5. Close the Epson Scan 2 Utility.

**Parent topic:** Replacing the Scanner Rollers

### Transporting Your Scanner

If you need to ship your product, transport it a long distance, or store it for an extended period, prepare it for transportation as described here.

1. Turn off the scanner and unplug the AC adapter.
2. Disconnect any connected cables.
3. Close the input tray extension and the input tray.

4. Place the scanner in its original packing materials, if possible, or use equivalent materials with cushioning around the product.

Parent topic: Cleaning and Transporting Your Scanner
Solving Problems

Check these sections for solutions to problems you may have using your product.

Scanner Light Status
Solving Scanning Problems
Solving Network Scanning Problems
Solving Scanned Image Quality Problems
Uninstall Your Scanner Software
Where to Get Help

Scanner Light Status

You can often diagnose problems with your scanner by checking its lights.

**ES-200**

1  ! error light
2  📑 automatic feeding mode light
3  Ready light
1 ! error light
2 📄 automatic feeding mode light
3 Ready light
4 📡 Wi-Fi light
5 🔋 battery light
<table>
<thead>
<tr>
<th>Light status</th>
<th>Condition/solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The ! error light is on and the ready light is flashing</td>
<td>A paper jam or a double feed has occurred. Remove any paper loaded in the input tray. If the light continues to flash, a scanner error may have occurred. Turn the scanner off and then back on again. If the error continues, contact Epson for support.</td>
</tr>
<tr>
<td>The scanner cover is open. Make sure the scanner cover is closed and there is no jammed paper inside.</td>
<td></td>
</tr>
<tr>
<td>The following lights are flashing separately or simultaneously:</td>
<td>A fatal error has occurred while using the scanner with a USB cable. Try the following:</td>
</tr>
<tr>
<td>• ready</td>
<td>• Check the scanner connection to your computer to make sure it is secure.</td>
</tr>
<tr>
<td>• ! error</td>
<td>• Turn the scanner off and then back on again. If the error continues, the scanner may be malfunctioning. Contact Epson for support.</td>
</tr>
<tr>
<td>The following lights are flashing separately or simultaneously:</td>
<td>A fatal error has occurred while using the scanner with Wi-Fi (ES-300W/ES-300WR). Turn the scanner off and then back on again. If the error continues, the scanner may be malfunctioning. Contact Epson for support.</td>
</tr>
<tr>
<td>• ready</td>
<td></td>
</tr>
<tr>
<td>• ! error</td>
<td></td>
</tr>
<tr>
<td>• Wi-Fi (ES-300W/ES-300WR)</td>
<td></td>
</tr>
<tr>
<td>The ready light is off and any of the following lights are on:</td>
<td>The firmware update has failed and the scanner is in recovery mode. Try updating the firmware again.</td>
</tr>
<tr>
<td>• ! error</td>
<td></td>
</tr>
<tr>
<td>• ☞ automatic feeding mode</td>
<td></td>
</tr>
<tr>
<td>• ● Wi-Fi (ES-300W/ES-300WR)</td>
<td></td>
</tr>
<tr>
<td>The following lights are flashing separately or simultaneously: (ES-300W/ES-300WR)</td>
<td>An access point settings error (security error) has occurred. Press the ☑ stop button to clear the error, restart the devices you want to connect to the network, then reconnect to the network.</td>
</tr>
</tbody>
</table>
### Light status

<table>
<thead>
<tr>
<th>Light status</th>
<th>Condition/solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The ! error light is on and the Wi-Fi light is flashing (ES-300W/ES-300WR)</td>
<td>Wireless scanning from the scanner button has failed. Wait for the lights to go off or stop flashing, restart the devices you want to connect to the network, and reconnect to the network.</td>
</tr>
<tr>
<td>The battery light is flashing orange quickly (ES-300W/ES-300WR)</td>
<td>The battery is too hot, damaged, or at the end of its service life and, therefore, unable to charge. Charge the battery within a temperature range of 46 to 95 °F (8 to 35 °C). If the error continues, the scanner may be malfunctioning. Contact Epson for support.</td>
</tr>
</tbody>
</table>

**Parent topic:** Solving Problems

**Related references**
- Original Jams in Scanner
- Where to Get Help

**Related topics**
- Loading Originals
- Wi-Fi Networking
- Scanning

---

### Solving Scanning Problems

Check these solutions if you have problems scanning with your product.

- **Scanner Does Not Turn On or Turns Off Unexpectedly**
- **Scanner Button Does Not Work as Expected**
- **Scanning Software Does Not Operate Correctly**
- **Cannot Start Epson Scan 2**
- **Original Feeds Incorrectly in Scanner**
- **Original Jams in Scanner**
- **Scanning is Slow**

**Parent topic:** Solving Problems

### Scanner Does Not Turn On or Turns Off Unexpectedly

If the scanner does not turn on or if it turns off unexpectedly, try these solutions:

- Make sure the AC adapter is securely connected to the scanner and to a working electrical outlet.
- If the scanner turns off unexpectedly, you may need to adjust the Power Off Timer setting.
• If you are using a USB connection, make sure the connection mode switch is set to the position (ES-300W/ES-300WR).
• Make sure you are operating the scanner within the operating temperature range (ES-300W/ES-300WR).
• Make sure the USB cable is securely connected to the computer.
• Connect the scanner directly to the computer. The scanner may not work properly when connected through a USB hub.
• Use the USB cable that came with the scanner.
• Use a USB 3.0 (SuperSpeed) port. You cannot use a USB 2.0 or USB 1.1 port to operate the scanner on a USB power supply.
• If the scanner does not turn off when operating on the battery (ES-300W/ES-300WR), disconnect the AC adapter and USB cable and press the reset button on the bottom of the scanner. Then reconnect the scanner and try again.

Parent topic: Solving Scanning Problems
Related tasks
Changing the Power Save Settings
Scanner Button Does Not Work as Expected

If the scanner button does not start the correct program or perform the correct action, try these solutions:

- Document Capture Pro (Windows) and Document Capture (Mac) do not support using the start button to scan over a wireless connection (ES-300W/ES-300WR). Connect the scanner using a USB cable or launch Epson Scan 2 before scanning from the button on your scanner.

  **Note**: If you installed the Epson ScanSmart software, pressing the start button on your scanner starts Epson ScanSmart instead, over a USB or wireless (ES-300W/ES-300WR) connection. For instructions on scanning with Epson ScanSmart, see the help information in Epson ScanSmart or click here to access the *Epson ScanSmart User's Guide*.

- Check the USB cable connection between the computer and scanner.
- In Windows, be sure that the scanner is listed under **Imaging Devices** in the Device Manager.
- Make sure Document Capture Pro (Windows) or Document Capture (Mac) is installed correctly. If necessary, uninstall and reinstall it.
- Make sure you have assigned the correct job to the scanner button and change it, if necessary.
- Check the status of the lights and make sure the scanner is ready to scan.
- Make sure the connection mode switch is set correctly (ES-300W/ES-300WR).
- When using a wireless connection, start Epson Scan 2 on your computer before scanning from the product (ES-300W/ES-300WR).
- Make sure Epson Scan 2 and other applications are installed correctly. If necessary, uninstall and reinstall it.

**Parent topic**: Solving Scanning Problems

**Related tasks**

- [Adding and Assigning Scan Jobs with Document Capture Pro - Windows](#)
- [Assigning Start Button Settings or Scan Jobs - Mac](#)

Scanning Software Does Not Operate Correctly

If your scanning software does not operate correctly, try these solutions:

- Make sure your computer has adequate memory and meets the system requirements for your operating system.
- Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so, wake your system and restart your scanning software.
• Make sure the scanner is turned on.
• Make sure the connection between the scanner and your computer is secure.
• If you upgraded your operating system but did not reinstall your scanning software, try reinstalling it.
• In Windows, be sure that the scanner is listed under Imaging Devices in the Device Manager.
• Connect the scanner directly to the computer. The scanner may not work properly when connected through a USB hub.
• If you are using a TWAIN-compliant program, make sure that the correct product is selected as the Scanner or Source setting.

Parent topic: Solving Scanning Problems

Related concepts
Uninstall Your Scanner Software

Related references
Windows System Requirements
Mac System Requirements

Cannot Start Epson Scan 2

If you cannot start Epson Scan 2, try these solutions:
• Restart your computer.
• Be sure to use the USB cable that came with the scanner.
• Make sure your scanner is turned on and any interface cables are securely connected at both ends.
• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so, wake your system and restart Epson Scan 2.
• Connect the scanner directly to the computer. The scanner may not work properly when connected through a USB hub.
• If you connected the scanner using a USB cable, make sure it is connected directly to your computer or through only one USB hub.
• If you upgraded your operating system but did not reinstall Epson Scan 2, try reinstalling it.
• If you are using a TWAIN-compliant program, make sure that the correct product is selected as the Scanner or Source setting.
• Make sure the ready light stops flashing, indicating that the scanner is ready to scan.

Parent topic: Solving Scanning Problems
Original Feeds Incorrectly in Scanner

If you have problems feeding originals in your scanner, try these solutions:

• If multiple pages feed at once, try the following:
  • Remove the originals, fan the edges to separate the sheets, if necessary, and reload them.
  • Load fewer originals at a time.
  • Load only originals that meet the specifications for your scanner.
  • Make sure the number of originals does not exceed the scanner's loading capacity. If loading a stack of originals, slide the stack so the leading edge is at an angle, as described in the loading instructions.
  • Clean inside the scanner and replace the roller assembly kit, if necessary.
  • Scan the originals one by one using the Automatic Feeding Mode setting in Epson Scan 2.
  • Use Automatic Feeding Mode in Epson Scan 2 and scan originals one at a time.

• If you see a double feed error in the Epson Scan 2 window or the Document Capture Pro window, start Epson Scan 2, select the Main Settings tab, select the Detect Double Feed setting, and select Off.

Note: On a Mac, only Epson Scan 2 displays double feed errors. Document Capture for Mac does not include this setting.

Parent topic: Solving Scanning Problems

Related references
Original Document Specifications
Receipt Specifications
Special Original Specifications
Plastic Card Specifications

Related tasks
Cleaning Inside Your Scanner
Original Jams in Scanner

If an original has jammed inside the scanner, follow these steps:

Note: The illustrations show the ES-300W/ES-300WR, but the instructions are the same for the ES-200.

1. Turn off your scanner.
2. Remove all originals from the input tray.
3. Pull the edge of the scanner cover firmly at the arrow mark.
4. Gently pull out any jammed originals from inside the scanner.

5. Close the scanner cover.
6. Carefully follow all loading instructions when you reload originals.

**Parent topic:** Solving Scanning Problems

**Related tasks**
Cleaning Inside Your Scanner

**Related topics**
Loading Originals

### Scanning is Slow

If scanning becomes slow, try these solutions:

- Scan your original at a lower resolution, if possible.
• Make sure your system meets the requirements for your operating system. If you are scanning a high-resolution image, you may need more than the minimum requirements. If necessary, increase your system’s memory or reduce the resolution.

• If you are running virus protection or other security software, exclude the TWAIN.log files from monitoring or set the TWAIN.log file as read only (Windows). See your virus protection or security software instructions for details. The TWAIN.log file is saved in C:\Users\(username)\AppData\Local\Temp.

**Note:** You may need to unhide system folders to view files in that location.

• If you are running on USB power, connect the AC adapter to the scanner.

• If you are running on battery power and the battery charge is low, connect the AC adapter to the scanner (ES-300W/ES-300WR).

**Parent topic:** Solving Scanning Problems

**Related references**

Windows System Requirements

Mac System Requirements

**Solving Network Scanning Problems**

Check these solutions if you have problems scanning over a network (ES-300W/ES-300WR).

**Cannot Scan Over a Network**

**Scanner Cannot Connect to a Wireless Router**

**Parent topic:** Solving Problems

**Cannot Scan Over a Network**

If you have problems scanning over a network, try these solutions:

• Make sure the connection mode switch is set to the Wi-Fi position.

• If you cannot scan from the start button on the scanner, make sure you restarted your computer after installing the scanning software. Also start Epson Scan 2 before scanning with the start button.

• Document Capture Pro (Windows) and Document Capture (Mac) do not support starting a scan from the scanner button over a wireless network (ES-300W/ES-300WR). Launch Epson Scan 2 before scanning from the scanner button over a network.
Note: If you installed the Epson ScanSmart software, pressing the start button on your scanner starts Epson ScanSmart instead, via a USB or wireless (ES-300W/ES-300WR) connection. For instructions on scanning with Epson ScanSmart, see the help information in Epson ScanSmart or click here to access the Epson ScanSmart User’s Guide.

• If you are scanning a large original at a high resolution, a network communication error may occur. Try scanning again at a lower resolution.
• If network communication was interrupted while starting Epson Scan 2, exit Epson Scan 2, wait a few seconds, and restart it. If Epson Scan 2 cannot restart, turn off your scanner, turn it back on, and try starting Epson Scan 2 again.
• Check the network connection setting in the Epson Scan 2 Utility.
• You may need to disable the firewall and any anti-virus software on your wireless router or access point.
• If you see the message "Network product is not available: currently being used by user", there may be a communication error between the scanner and computer. Restart the scanner.
• Epson Scan 2 does not support networks that use only IPv6. Use Epson Scan 2 on a network that supports IPv4.
• If the Firewall function is active, the scanner may not be discovered by the Epson Scan 2 Utility. Open the Epson Scan 2 Utility, enter the IP address for your scanner, and click Add.

Parent topic: Solving Network Scanning Problems
Related topics
Wi-Fi Networking

Scanner Cannot Connect to a Wireless Router
If your scanner has trouble finding or connecting to a wireless router, try these solutions:

• If you are connecting the scanner via Wi-Fi Protected Setup (WPS), make sure you activate WPS on your scanner within 2 minutes of activating WPS discovery mode on the router by pressing the WPS button or enabling the WPS setting in your router firmware.
• Make sure to place your scanner within contact range of your router. Avoid placing your scanner near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for instructions. Be sure to connect your scanner only to a 2.4 GHz network name (SSID).

- Verify that your router is operating correctly by connecting to it from your computer or another device.
- You may need to temporarily disable your firewall and any anti-virus software on your wireless router. Then try scanning again. You can also unblock your scanner driver or network address in your firewall or anti-virus software.
- Check to see if access restrictions, such as MAC address filtering, are set on the router. If access restrictions are set, add your scanner's MAC address to your router's address list. To obtain your scanner's MAC address, check the label on the back or bottom of your scanner. Then follow the instructions in your router documentation to add the address to the list.
- If your router does not broadcast its network name (SSID), follow the instructions that came with your scanner to enter your wireless network name manually.
- If your router has security enabled, determine the kind of security it is using and any required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA passphrase correctly.
- Check if your computer is restricting the available wireless channels. If so, verify that your wireless access point is using one of the usable channels and change to a usable channel, if necessary.
- The scanner may not be able to communicate with a computer with multiple network interfaces. Disable all network interfaces except for the interface connected to the scanner.
- Enable the DHCP function on the access point or router.
- Check that the scanner's IP address is set correctly.

Parent topic: Solving Network Scanning Problems

Related topics

Wi-Fi Networking

Solving Scanned Image Quality Problems

Check these sections if a scanned image on your computer screen has a quality problem.

- Back of Original Image Appears in Scanned Image
- Scanned Characters are Blurry
- Characters are not Recognized During Conversion to Editable Text (OCR)
- Ripple Patterns Appear in an Image
- Spots or Lines Appear in All Scanned Images
Back of Original Image Appears in Scanned Image

If an image from the back of a thin original appears in your scanned image, make sure you selected the correct Image Type setting for your original and select the **Text Enhancement** setting in Epson Scan 2. You can also select the **Remove Background** setting in Epson Scan 2.

**Note:** If you select **Color** as the Image Type setting, you can change the level from Standard to High to remove more of the background.

Related references
- Image Format Options

Related tasks
- Scanning in Epson Scan 2

Scanned Characters are Blurry

If characters in your scanned images are blurry, try these solutions:

- Make sure the mode selector is set correctly. To scan using the ADF, slide the mode selector to 📜. To scan a plastic card using the card slot, slide the mode selector to 🌐.
- Make sure you do not move the scanner or original while scanning.
- Operate the scanner on a flat, stable surface.
- Make sure the originals are ejecting properly.
- Adjust these Epson Scan 2 settings (if available) and try scanning again:
  - Select the **Text Enhancement** setting.
  - If the **Image Type** setting is **Black & White**, adjust the **Threshold** setting.
  - Increase the **Resolution** setting.
  - Set the **Image Type** to **Grayscale**.

Parent topic: Solving Scanned Image Quality Problems
Characters are not Recognized During Conversion to Editable Text (OCR)

If characters in your scanned images are not recognized during OCR conversion, try these solutions:

• Make sure your original is loaded straight on your product.
• Use an original with clear text.
• Adjust these Epson Scan 2 settings (if available) and try scanning again:
  • Select the correct **Image Type** setting.
  • Select or adjust the **Text Enhancement** setting.
  • If the **Image Type** is set to **Black & White**, adjust the **Threshold** setting.
  • Set the **Image Type** to **Grayscale**.
• Set the scanning resolution between 200 and 600 dpi.
• If the original document is in landscape mode, set the **Rotate** setting to **Auto** in Epson Scan 2.
• If you are using OCR software, check the manual for any additional adjustments.

Parent topic: Solving Scanned Image Quality Problems

Ripple Patterns Appear in an Image

You may see a ripple pattern (called a moiré) in scanned images of printed documents. This is caused by interference from differing pitches in the scanner's screen and your original's halftone screen. To reduce this effect, adjust these Epson Scan 2 settings (if available) and try scanning again:

• Select the **Descreeking** setting.
• Select a lower **Resolution** setting.

Parent topic: Solving Scanned Image Quality Problems
Spots or Lines Appear in All Scanned Images

If spots or lines appear in all your scanned images, try these solutions:

- Make sure the surface of the original clean.
- Disconnect any connected cables and clean inside the scanner.

Parent topic: Solving Scanned Image Quality Problems

Related tasks
Cleaning Inside Your Scanner

Scanned Image is Cropped

If the edges of a scanned image are cropped, try the following solutions:

- Select Auto Detect or Auto Detect (Long Paper) as the Document Size setting in Epson Scan 2, Document Capture Pro, or Document Capture.

  Note: The maximum paper length is 44 inches (1117.6 mm); select Customize to create a custom paper size.

- In Epson Scan 2, select the Main Settings tab. Select Document Size > Settings and adjust the cropping area shown in the Crop Margins for Size "Auto" setting.

- Document Capture Pro (Windows): Select Detailed Settings from the Scan window. Select Document Size > Settings and then adjust the cropping area shown in the Crop Margins for Size "Auto" setting.

- Document Capture (Mac): Click the Scan button and select Main Settings from the Scan window. Select Document Size and then adjust the cropping area shown in the Crop Margins for Size "Auto" setting.

Parent topic: Solving Scanned Image Quality Problems
Resetting the Epson Scan 2 Settings

If you continue to experience image quality problems after trying all possible solutions, you may need to reset the Epson Scan 2 settings using the Epson Scan 2 Utility.

1. Do one of the following to start the Epson Scan 2 Utility:
   - Windows 10: Click > EPSON > Epson Scan 2 Utility.
   - Windows 8.x: Navigate to the Apps screen and select Epson Scan 2 Utility.
   - Windows (other versions): Click or Start, and select All Programs or Programs. Select EPSON > Epson Scan 2 > Epson Scan 2 Utility.
   - Mac: Open the Applications folder, open the Epson Software folder, and select Epson Scan 2 Utility.

2. Click the Other tab.
3. Click Reset and confirm your choice.

Note: If resetting the Epson Scan 2 settings does not solve your problem, uninstall Epson Scan 2 and re-install it.

Parent topic: Solving Scanned Image Quality Problems

Uninstall Your Scanner Software

If you have a problem that requires you to uninstall and re-install your software, follow the instructions for your operating system.

Uninstalling Scanner Software - Windows

Uninstalling Scanner Software - Mac

Parent topic: Solving Problems

Uninstalling Scanner Software - Windows

You can uninstall and then re-install your scanner software to solve certain problems.

1. Turn off the scanner.
2. Disconnect any interface cables.
3. Do the following to uninstall each of your scanning software programs and follow any on-screen instructions:

- **Windows 10**: Click and select (Settings) > Apps > Apps & features. Select the scanner software program and click Uninstall.

- **Windows 8.x**: Navigate to the Apps screen and select Control Panel > Programs > Programs and Features. Select the scanner software program and click Uninstall/Change.

- **Windows 7**: Open the Windows Control Panel utility. Select Programs and Features. (In Classic view, select Programs and click Uninstall a program.) Select the scanner software program and click Uninstall/Change.

4. Restart your computer, then see the Start Here sheet to re-install your software.

   **Note**: If you find that re-installing your scanner software does not solve a problem, contact Epson.

**Parent topic**: Uninstall Your Scanner Software

### Uninstalling Scanner Software - Mac

In most cases, you do not need to uninstall your scanner software before re-installing it. However, you can download the Uninstaller utility from the Epson support website to uninstall your scanner software as described here.

1. To download the Uninstaller utility, visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.

2. Follow the instructions on the screen to install the Uninstaller utility.

3. Quit all applications currently running on your Mac.

4. Double-click the Uninstaller icon.

5. In the Epson Uninstaller screen, select the checkbox for each software program you want to uninstall.

6. Click Uninstall.

7. Follow the on-screen instructions to uninstall the software.

8. To reinstall your scanner software, see the Start Here sheet for instructions.

   **Note**: If you find that re-installing your scanner software does not solve a problem, contact Epson.

**Parent topic**: Uninstall Your Scanner Software
Where to Get Help

If you need to contact Epson for technical support services, use the following support options.

Internet Support
Visit Epson’s support website at epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product for solutions to common problems with your product. You can download utilities and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:

• Product name
• Product serial number (located on a label on the product)
• Proof of purchase (such as a store receipt) and date of purchase
• Computer configuration
• Description of the problem

Then call:

• U.S.: (562) 276-4382, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Pacific Time, Saturday
• Canada: (905) 709-3839, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Pacific Time, Saturday

Days and hours of support are subject to change without notice. Toll or long distance charges may apply.

Note: For help using any other software on your system, see the documentation for that software for technical support.

Purchase Supplies and Accessories
You can purchase genuine Epson accessories at epson.com (U.S. sales), epson.ca (Canadian sales), or epson.com.jm (Caribbean sales). You can also purchase accessories from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

Parent topic: Solving Problems
Technical Specifications

These sections list the technical specifications for your scanner.

**Note:** Epson offers a recycling program for end of life Epson products. Please go to [this site](https://www.epson.com) (U.S) or [this site](https://www.epson.ca) (Canada) for information on how to return your Epson products for proper disposal.

Windows System Requirements
Mac System Requirements
General Specifications
Dimension Specifications
Electrical Specifications
Environmental Specifications
Network Interface Specifications (ES-300W/ES-300WR)
Safety and Approvals Specifications

**Windows System Requirements**

To use your product and its software, your computer should use one of these Microsoft operating systems:

- Windows 10
- Windows 8.x
- Windows 7

**Note:** For the latest product software available for your operating system, visit the Epson support site at [epson.com/support](https://www.epson.com/support) (U.S.), [epson.ca/support](https://www.epson.ca/support) (Canada), or [epson.com.jm/support](https://www.epson.com.jm/support) (Caribbean), select your product, and select **Downloads**.

Parent topic: Technical Specifications

**Mac System Requirements**

To use your product and its software, your Mac should use one of these operating systems:

- macOS 10.13.x
- macOS 10.12.x
• OS X 10.11.x
• OS X 10.10.x
• OS X 10.9.x
• OS X 10.8.x
• OS X 10.7.x
• OS X 10.6.8
To use the Epson ScanSmart software, your Mac must use one of these operating systems:
• macOS 10.13.x
• macOS 10.12.x
• OS X 10.11.x

Note: The UNIX File System (UFS) for OS X is not supported.

Note: For the latest product software available for your operating system, visit the Epson support site at epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean), select your product, and select Downloads.

Parent topic: Technical Specifications

General Specifications

Scanner type  Portable, sheet feed, one pass duplex, color
Photoelectric device  CIS
Effective pixels  
5100 × 8700 pixels at 600 dpi
5100 × 13200 pixels at 300 dpi
Document size
- Maximum: 8.5 × 44 inches (215.9 × 1117.6 mm)
- Minimum: 3.5 × 2.75 inches (89 × 70 mm)
- With Epson ScanSmart (ES-300WR):
  - Receipts scanned at 301 dpi or more: up to 8.5 × 15.5 inches (215.9 × 393.8 mm)
  - Receipts scanned at 300 dpi or less: up to 3.14 × 26 inches (79 × 660 mm) at a width of 3.14 inches (79 mm) or less
  - Receipts scanned at 300 dpi or less: up to 8.5 × 36 inches (215.9 × 914.4 mm) at a width of 3.15 inches (80 mm) or more

Paper input
- Facedown loading (ADF)
- Faceup loading (card slot)

Paper output
- Facedown ejection (ADF)
- Faceup ejection (card slot)

Paper capacity
- 25 sheets of paper at 17 lb (64 g/m²) weight
- 20 sheets of paper at 21 lb (80 g/m²) weight
- 12 sheets of paper at 34 lb (128 g/m²) weight
- Stack of originals: less than 0.07 inches (2 mm) thick

Scanning resolution
- 600 dpi (main scan)
- 600 dpi (sub scan)

Output resolution
- 50 to 1200 dpi (in 1 dpi increments)
- 50 to 300 dpi for scans from 14.5 to 44 inches (368.3 to 1117.6 mm)
**Color depth**

Color:
- 48 bits per pixel internal (16 bits per pixel per color internal)
- 24 bits per pixel external (8 bits per pixel per color external)

Grayscale:
- 16 bits per pixel internal
- 8 bits per pixel external

Black and white:
- 16 bits per pixel internal
- 8 bits per pixel external

**Interface**

Super-Speed USB port

IEEE802.11b/g/n (ES-300W/ES-300WR)

(You cannot use a USB and network connection at the same time [ES-300W/ES-300WR].)

**Light source**

RGB LED

---

**Dimension Specifications**

**Height**

ES-200:
- 2 inches (51 mm)

ES-300W/ES-300WR:
- 2.6 inches (67 mm)

**Width**

11.3 inches (288 mm)

**Depth**

3.5 inches (88.5 mm)

**Weight**

ES-200:
- 2.4 lb (1.1 kg)

ES-300W/ES-300WR:
- 2.9 lb (1.3 kg)
Note: Dimensions do not include projecting parts.

Parent topic: Technical Specifications

Electrical Specifications

Scanner

Note: Check the label on the scanner and the AC adapter for voltage information. Power consumption varies depending on operating conditions or whether an option is installed.

Rated input voltage       DC 5 V
Rated input current       3 A
Power consumption
    ES-200:
        Operating: 8 W (approximately)
        Ready mode: 2.5 W (approximately)
        Sleep mode: 0.9 W (approximately)
        Power off mode: 0.3 W or less
    ES-300W/ES-300WR (USB connection):
        Operating: 8 W (approximately)
        Ready mode: 2.6 W (approximately)
        Sleep mode: 1.2 W (approximately)
        Power off mode: 0.5 W or less
    ES-300W/ES-300WR (Wi-Fi connection):
        Operating: 10 W (approximately)
        Ready mode: 3.9 W (approximately)
        Sleep mode: 2.4 W (approximately)
        Power off mode: 0.5 W or less
AC Adapter

AC adapter model
100 to 240 V model: A491H
220 to 240 V model: A492E

Rated input current 0.6 A
Rated input frequency 50 to 60 Hz
Rated output voltage DC 5 V
Rated output current 3 A

Battery (ES-300W/ES-300WR)

Type Li-ion
Rated voltage 3.6 V
Rated capacity 2090mAh
Charging time AC adapter: 3 hours (approximately)
USB 3.0 port: 4 hours (approximately)
USB 2.0 port: 20 hours (approximately)
(USB charging times with scanner turned on; if the scanner is turned off, charging takes longer.)

Parent topic: Technical Specifications

Environmental Specifications

Temperature
Operating: 41 to 95 °F (5 to 35 °C)
Charging: 46 to 95 °F (8 to 35 °C) (ES-300W/ES-300WR)
Storage:
ES-200: –13 to 140 °F (–25 to 60 °C)
ES-300W/ES-300WR: –4 to 140 °F (–20 to 60 °C)

Humidity
Operating: 15 to 80% RH
(non-condensing)
Storage: 15 to 85% RH
Operating conditions

Ordinary office or home conditions

**Note:** Avoid operating the scanner in direct sunlight, near a strong light source, or in extremely dusty conditions.

**Parent topic:** Technical Specifications

### Network Interface Specifications (ES-300W/ES-300WR)

<table>
<thead>
<tr>
<th>Wireless LAN standard</th>
<th>IEEE 802.11 b/g/n</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wireless security</td>
<td>WPA2-PSK (AES); WPA2 compliant with support for WPA/WPA2</td>
</tr>
<tr>
<td></td>
<td>Personal</td>
</tr>
<tr>
<td></td>
<td>WEP (64/128 bit)</td>
</tr>
<tr>
<td>Frequency range</td>
<td>2.4 GHz</td>
</tr>
<tr>
<td>Coordination modes</td>
<td>Infrastructure mode</td>
</tr>
<tr>
<td></td>
<td>AP mode; not supported for IEEE802.11b</td>
</tr>
<tr>
<td>Maximum radio-frequency</td>
<td>18.2 dBm (EIRP)</td>
</tr>
<tr>
<td>power transmitted</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** AP mode connection and Wi-Fi connection can be used at the same time.

**Parent topic:** Technical Specifications

### Safety and Approvals Specifications

**Scanner**

<table>
<thead>
<tr>
<th>United States</th>
<th>EMC: FCC part 15 Subpart B class B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canada</td>
<td>EMC: CAN/CSA-CEI/IEC CISPR 22 Class B</td>
</tr>
</tbody>
</table>

**AC Adapter (A491H)**

<table>
<thead>
<tr>
<th>United States</th>
<th>Safety: UL60950-1</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>EMC: FCC part 15 Subpart B class B</td>
</tr>
</tbody>
</table>
Canada

Safety: CAN/CSA C22.2 No. 60950-1
EMC: CAN/CSA-CEI/IEC CISPR 22 Class B

ES-300W/ES-300WR:
This equipment contains the following wireless module:

• Manufacturer: Askey Computer Corporation.
• Type: WLU6117-D69 (RoHS)

This product conforms to Part 15 of FCC Rules and RSS-210 of the IC Rules. Epson cannot accept responsibility for any failure to satisfy the protection requirements resulting from a non-recommended modification of the product. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to licensing.

This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment and meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102 of the IC radio frequency (RF) Exposure rules. This equipment should be installed and operated so that the radiator is kept at least 7.9 inches (20 cm) or more away from a person's body (excluding extremities: hands, wrists, feet and ankles).

Notice for Paraguay
Imported by:
Fastrax, S.A.
Av. Perú esq. Río de Janeiro, Barrio Las Mercedes, Asunción, Paraguay
Imported by:
Sol Control S.R.L.
Av. Gral. Bernardino Caballero 810 esq. Celsa Speratti, Asunción, Paraguay

Notice for Peru
Product Model: ES-300W (J391A)
Brand: EPSON
This product uses the following WLAN module:
WLAN Module Model: WLU6117-D69 (RoHS)
FCC ID: BKMFBWLU6117
Product Manufacturer: Seiko Epson Corporation
Address: 3-3-5 Owa Suwa-shi, Nagano-Ken 392-8502, Japan

Parent topic: Technical Specifications
Notices

Check these sections for important notices about your scanner.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S) or this site (Canada) for information on how to return your Epson products for proper disposal.

Important Safety Instructions

Battery Safety Instructions (ES-300W/ES-300WR)
Restrictions on Copying
Default Delay Times for Power Management for Epson Products
Binding Arbitration and Class Waiver
Trademarks
Copyright Notice

Important Safety Instructions

Follow these safety instructions when setting up and using the scanner:

• Read all these instructions, and follow all warnings and instructions marked on the scanner.
• Place the scanner close enough to the computer for the interface cable to reach it easily.
• Do not use with wet hands.
• When connecting this product to a computer or other device with a cable, ensure the correct orientation of the connectors. Each connector has only one correct orientation. Inserting a connector in the wrong orientation may damage both devices connected by the cable.
• Do not insert objects into any opening as they may touch dangerous voltage points or short out parts. Beware of electrical shock hazards.
• Place the product on a flat, stable surface that extends beyond the base of the product in all directions. If you place the product by the wall, leave at least 3.9 inches (10 cm) between the back of the product and the wall.
• After replacing consumable parts, dispose of them correctly following the rules of your local authority. Do not disassemble them.
• Do not place or store the scanner outdoors, in a car, near excessive dirt or dust, water, heat sources, or in locations subject to shocks, vibrations, condensation, high temperature or humidity, direct sunlight, strong light sources, or rapid changes in temperature or humidity.
• Never disassemble, modify, or attempt to repair the scanner or a scanner option by yourself except as specifically explained in this guide.

Caution: Radio waves from this product may adversely affect the operation of medical equipment, airplanes, or automatically controlled devices, such as pacemakers, automatic doors, or fire alarms. When using this product near such devices or inside a medical facility, follow the directions from authorized staff members at the facility, and follow all posted warnings and directions on the device to avoid causing an accident.

Warning: The cords included with this product contain chemicals, including lead, known to the State of California to cause birth defects or other reproductive harm. Wash hands after handling. (This notice is provided in accordance with Proposition 65 in Cal. Health & Safety Code § 25249.5 and following.)

AC Adapter
• Do not place or store the AC adapter outdoors, in a car, near excessive dirt or dust, water, heat sources, or in locations subject to shocks, vibrations, condensation, high temperature or humidity, direct sunlight, strong light sources, or rapid changes in temperature or humidity.
• Place the scanner and the AC adapter near an electrical outlet where the adapter can be easily unplugged.
• The AC power cord should be placed to avoid abrasions, cuts, fraying, crimping, and kinking.
• Do not place objects on top of the AC power cord and do not allow the AC adapter or the power cord to be stepped on or run over. Be particularly careful to keep the AC power cord straight at the end and the point where it enters the AC adapter.
• Use only the AC adapter that comes with your scanner. Using any other adapter could cause fire, electrical shock, or injury.
• Use only the AC adapter that comes with your scanner. Use of another cord may cause fires or shock. Do not use the cord with any other equipment.
• The AC adapter is designed for use with the scanner with which it was included. Do not attempt to use it with other electronic devices unless specified.
• Use only the type of power source indicated on the AC adapter's label, and always supply power directly from a standard domestic electrical outlet with the AC adapter that meets the relevant local safety standards.
• Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.
• If you use an extension cord with the scanner, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord's ampere rating. Also, make sure the total
ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere rating.

• Never disassemble, modify, or attempt to repair the AC adapter by yourself except as specifically explained in the scanner's guides.

• If damage occurs to the plug, replace the cord set or consult a qualified electrician. If there are fuses in the plug, make sure you replace them with fuses of the correct size and rating.

• Unplug the scanner and the AC adapter, and refer servicing to qualified service personnel under the following conditions: The AC adapter or plug is damaged; liquid has entered the scanner or the AC adapter; the scanner or the AC adapter has been dropped or the case has been damaged; the scanner or the AC adapter does not operate normally or exhibits a distinct change in performance. (Do not adjust controls that are not covered by the operating instructions.)

• Unplug the scanner and the AC adapter before cleaning. Clean with a damp cloth only. Do not use liquid or aerosol cleaners.

• If you are not going to use the scanner for a long period, be sure to unplug the AC adapter from the electrical outlet.

Parent topic: Notices

Battery Safety Instructions (ES-300W/ES-300WR)

• The battery is not fully charged at the time of purchase. Charge the battery fully before using the scanner on battery power.

• Always charge the battery within a temperature range of 46°F to 95°F (8°C to 35°C). The battery cannot charge or may deteriorate if you charge it in an environment outside of this range.

• If the battery is not fully charged within the specified time, stop charging. Otherwise, the battery could become hot, emit smoke, rupture, or catch fire.

• If you are not using the scanner, charge the battery using the AC adapter on a regular basis (at least once every six months) to avoid letting the battery run out.

• Turn off the scanner when not in use or set the scanner to turn off automatically to save battery power.

• Do not place the product in a microwave oven or a high-pressure container. Otherwise, the battery could become hot, emit smoke, rupture, or catch fire.

• If battery acid gets into your eyes or on your skin, immediately rinse the affected area thoroughly with water and seek medical treatment.

• If battery acid leaks from a battery, or the product emits a bad odor, move the product away from flammable objects immediately. If the product is not moved, electrolytes leaking from the battery could become hot, emit smoke, rupture, or catch fire.
• Do not subject the scanner to physical impacts or drop the scanner. Otherwise, the battery could leak or the protection circuit in the battery could be damaged. As a result, the battery could become hot, emit smoke, rupture, or catch fire.

• Do not use or place the product in temperatures exceeding 140°F (60°C), such as near a fire or a heater. Otherwise, the plastic separator could melt and the individual cells could short-circuit. As a result, the battery could become hot, emit smoke, rupture, or catch fire.

• Do not use the product if it is leaking or damaged in any way. Otherwise, the battery could become hot, emit smoke, rupture, or catch fire.

• Do not leave the product in a vehicle. Otherwise, the battery could overheat.

• If the scanner's battery light flashes orange quickly during charging in the normal temperature range (46°F to 95°F [8°C to 35°C]) or the battery runs out too fast even on a full charge, the battery may be malfunctioning or at the end of its service life. Contact Epson support to replace the battery.

Parent topic: Notices

Restrictions on Copying

Observe the following restrictions to ensure responsible and legal use of your scanner.

Copying of the following items is prohibited by law:

• Bank bills, coins, government-issued marketable securities, government bond securities, and municipal securities

• Unused postage stamps, pre-stamped postcards, and other official postal items bearing valid postage

• Government-issued revenue stamps, and securities issued according to legal procedure

Exercise caution when copying the following items:

• Private marketable securities (stock certificates, negotiable notes, checks, etc.), monthly passes, concession tickets, etc.

• Passports, driver's licenses, warrants of fitness, road passes, food stamps, tickets, etc.

Note: Copying these items may also be prohibited by law.

Restriction on disassembling and decompiling

You may not disassemble, decompile, or otherwise attempt to derive the source code of any software included with this product.

Parent topic: Notices
Default Delay Times for Power Management for Epson Products

This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to sleep to a shorter interval.

Parent topic: Notices

Binding Arbitration and Class Waiver

1. DISPUTES, BINDING INDIVIDUAL ARBITRATION, AND WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS

1.1 Disputes. The terms of this Section 1 shall apply to all Disputes between you and Epson. The term "Dispute" is meant to have the broadest meaning permissible under law and includes any dispute, claim, controversy or action between you and Epson arising out of or relating to this Agreement, Epson branded products (hardware and including any related software), or other transaction involving you and Epson, whether in contract, warranty, misrepresentation, fraud, tort, intentional tort, statute, regulation, ordinance, or any other legal or equitable basis. "DISPUTE" DOES NOT INCLUDE IP CLAIMS, or more specifically, a claim or cause of action for (a) trademark infringement or dilution, (b) patent infringement, (c) copyright infringement or misuse, or (d) trade secret misappropriation (an "IP Claim"). You and Epson also agree, notwithstanding Section 1.6, that a court, not an arbitrator, may decide if a claim or cause of action is for an IP Claim.

1.2 Binding Arbitration. You and Epson agree that all Disputes shall be resolved by binding arbitration according to this Agreement. ARBITRATION MEANS THAT YOU WAIVE YOUR RIGHT TO A JUDGE OR JURY IN A COURT PROCEEDING AND YOUR GROUNDS FOR APPEAL ARE LIMITED. Pursuant to this Agreement, binding arbitration shall be administered by JAMS, a nationally recognized arbitration authority, pursuant to its code of procedures then in effect for consumer related disputes, but excluding any rules that permit joinder or class actions in arbitration (for more detail on procedure, see Section 1.6 below). You and Epson understand and agree that (a) the Federal Arbitration Act (9 U.S.C. §1, et seq.) governs the interpretation and enforcement of this Section 1, (b) this Agreement memorializes a transaction in interstate commerce, and (c) this Section 1 shall survive termination of this Agreement.

1.3 Pre-Arbitration Steps and Notice. Before submitting a claim for arbitration, you and Epson agree to try, for sixty (60) days, to resolve any Dispute informally. If Epson and you do not reach an agreement to resolve the Dispute within the sixty (60) days), you or Epson may commence an arbitration. Notice to Epson must be addressed to: Epson America, Inc., ATTN: Legal Department, 3840 Kilroy Airport Way, Long Beach, CA 90806 (the "Epson Address"). The Dispute Notice to you will be sent to the most recent address Epson has in its records for you. For this reason, it is important to notify us if your address changes by emailing us at EAILegal@ea.epson.com or writing us at the Epson Address above. Notice of the Dispute shall include the sender's name, address and contact information, the facts giving rise to the
Dispute, and the relief requested (the "Dispute Notice"). Following receipt of the Dispute Notice, Epson and you agree to act in good faith to resolve the Dispute before commencing arbitration.

1.4 Small Claims Court. Notwithstanding the foregoing, you may bring an individual action in the small claims court of your state or municipality if the action is within that court's jurisdiction and is pending only in that court.

1.5 WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS. YOU AND EPSON AGREE THAT EACH PARTY MAY BRING DISPUTES AGAINST THE OTHER PARTY ONLY IN AN INDIVIDUAL CAPACITY, AND NOT AS A PLAINTIFF OR CLASS MEMBER IN ANY CLASS OR REPRESENTATIVE PROCEEDING, INCLUDING WITHOUT LIMITATION FEDERAL OR STATE CLASS ACTIONS, OR CLASS ARBITRATIONS. CLASS ACTION LAWSUITS, CLASS-WIDE ARBITRATIONS, PRIVATE ATTORNEY-GENERAL ACTIONS, AND ANY OTHER PROCEEDING WHERE SOMEONE ACTS IN A REPRESENTATIVE CAPACITY ARE NOT ALLOWED. ACCORDINGLY, UNDER THE ARBITRATION PROCEDURES OUTLINED IN THIS SECTION, AN ARBITRATOR SHALL NOT COMBINE OR CONSOLIDATE MORE THAN ONE PARTY'S CLAIMS WITHOUT THE WRITTEN CONSENT OF ALL AFFECTED PARTIES TO AN ARBITRATION PROCEEDING.

1.6 Arbitration Procedure. If you or Epson commences arbitration, the arbitration shall be governed by the rules of JAMS that are in effect when the arbitration is filed, excluding any rules that permit arbitration on a class or representative basis (the "JAMS Rules"), available at http://www.jamsadr.com or by calling 1-800-352-5267, and under the rules set forth in this Agreement. All Disputes shall be resolved by a single neutral arbitrator, and both parties shall have a reasonable opportunity to participate in the selection of the arbitrator. The arbitrator is bound by the terms of this Agreement. The arbitrator, and not any federal, state or local court or agency, shall have exclusive authority to resolve all disputes arising out of or relating to the interpretation, applicability, enforceability or formation of this Agreement, including any claim that all or any part of this Agreement is void or voidable. Notwithstanding this broad delegation of authority to the arbitrator, a court may determine the limited question of whether a claim or cause of action is for an IP Claim, which is excluded from the definition of "Disputes" in Section 1.1 above. The arbitrator shall be empowered to grant whatever relief would be available in a court under law or in equity. The arbitrator may award you the same damages as a court could, and may award declaratory or injunctive relief only in favor of the individual party seeking relief and only to the extent necessary to provide relief warranted by that party's individual claim. In some instances, the costs of arbitration can exceed the costs of litigation and the right to discovery may be more limited in arbitration than in court. The arbitrator's award is binding and may be entered as a judgment in any court of competent jurisdiction.

You may choose to engage in arbitration hearings by telephone. Arbitration hearings not conducted by telephone shall take place in a location reasonably accessible from your primary residence, or in Orange County, California, at your option.

a) Initiation of Arbitration Proceeding. If either you or Epson decides to arbitrate a Dispute, both parties agree to the following procedure:
(i) Write a Demand for Arbitration. The demand must include a description of the Dispute and the amount of damages sought to be recovered. You can find a copy of a Demand for Arbitration at http://www.jamsadr.com ("Demand for Arbitration").

(ii) Send three copies of the Demand for Arbitration, plus the appropriate filing fee, to: JAMS, 500 North State College Blvd., Suite 600 Orange, CA 92868, U.S.A.

(iii) Send one copy of the Demand for Arbitration to the other party (same address as the Dispute Notice), or as otherwise agreed by the parties.

b) Hearing Format. During the arbitration, the amount of any settlement offer made shall not be disclosed to the arbitrator until after the arbitrator determines the amount, if any, to which you or Epson is entitled. The discovery or exchange of non-privileged information relevant to the Dispute may be allowed during the arbitration.

c) Arbitration Fees. Epson shall pay, or (if applicable) reimburse you for, all JAMS filings and arbitrator fees for any arbitration commenced (by you or Epson) pursuant to provisions of this Agreement.

d) Award in Your Favor. For Disputes in which you or Epson seeks $75,000 or less in damages exclusive of attorney's fees and costs, if the arbitrator's decision results in an award to you in an amount greater than Epson's last written offer, if any, to settle the Dispute, Epson will: (i) pay you $1,000 or the amount of the award, whichever is greater; (ii) pay you twice the amount of your reasonable attorney's fees, if any; and (iii) reimburse you for any expenses (including expert witness fees and costs) that your attorney reasonably accrues for investigating, preparing, and pursuing the Dispute in arbitration. Except as agreed upon by you and Epson in writing, the arbitrator shall determine the amount of fees, costs, and expenses to be paid by Epson pursuant to this Section 1.6d).

e) Attorney's Fees. Epson will not seek its attorney's fees and expenses for any arbitration commenced involving a Dispute under this Agreement. Your right to attorney's fees and expenses under Section 1.6d) above does not limit your rights to attorney's fees and expenses under applicable law; notwithstanding the foregoing, the arbitrator may not award duplicative awards of attorney's fees and expenses.

1.7 Opt-out. You may elect to opt-out (exclude yourself) from the final, binding, individual arbitration procedure and waiver of class and representative proceedings specified in this Agreement by sending a written letter to the Epson Address within thirty (30) days of your assent to this Agreement (including without limitation the purchase, download, installation of the Software or other applicable use of Epson Hardware, products and services) that specifies (i) your name, (ii) your mailing address, and (iii) your request to be excluded from the final, binding individual arbitration procedure and waiver of class and representative proceedings specified in this Section 1. In the event that you opt-out consistent with the procedure set forth above, all other terms shall continue to apply, including the requirement to provide notice prior to litigation.

1.8 Amendments to Section 1. Notwithstanding any provision in this Agreement to the contrary, you and Epson agree that if Epson makes any future amendments to the dispute resolution procedure and
class action waiver provisions (other than a change to Epson’s address) in this Agreement, Epson will obtain your affirmative assent to the applicable amendment. If you do not affirmatively assent to the applicable amendment, you are agreeing that you will arbitrate any Dispute between the parties in accordance with the language of this Section 1 (or resolve disputes as provided for in Section 1.7, if you timely elected to opt-out when you first assented to this Agreement).

1.9 Severability. If any provision in this Section 1 is found to be unenforceable, that provision shall be severed with the remainder of this Agreement remaining in full force and effect. The foregoing shall not apply to the prohibition against class or representative actions as provided in Section 1.5. This means that if Section 1.5 is found to be unenforceable, the entire Section 1 (but only Section 1) shall be null and void.

Parent topic: Notices

Trademarks

EPSON® is a registered trademark and EPSON Exceed Your Vision is a registered logomark of Seiko Epson Corporation.

Windows is a registered trademark of Microsoft Corporation in the United States and/or other countries.

Apple, App Store, Mac, macOS, and OS X are trademarks of Apple Inc., registered in the U.S. and other countries.

Google® is a registered trademark, and Android™ Google Play™ are trademarks of Google LLC.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

Parent topic: Notices

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other products.
Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that occurs from the use of any interface cables other than those designated as Epson approved Products by Seiko Epson Corporation.

This information is subject to change without notice.

libTIFF Software Acknowledgment

A Note Concerning Responsible Use of Copyrighted Materials

Copyright Attribution

Parent topic: Notices

libTIFF Software Acknowledgment

Copyright © 1988-1997 Sam Leffler


Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (I) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Parent topic: Copyright Notice
A Note Concerning Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any Epson product. While some countries’ laws permit limited copying or reuse of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. Contact your legal advisor for any questions regarding copyright law.

Parent topic: Copyright Notice

Copyright Attribution

© 2020 Epson America, Inc.
1/20
CPD-52019R4
Parent topic: Copyright Notice